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Warenzeichen 

Das DCI Logo, DataLog
®
, DigiTrak

®
, Eclipse

®
, F5

®
, MFD

®
,
 
SST

®
 und TensiTrak

® 
sind in den USA

eingetragene Marken und Ball-in-the-Box™, F Series™, FSD™ und LWD™ sind Marken von Digital 
Control Incorporated. Bluetooth ist eine eingetragene Marke von Bluetooth SIG Inc. 

Patente 

Das in dieser Anleitung behandelte Produkt ist durch Patente in den USA und anderen Ländern 
geschützt. Einzelheiten dazu finden Sie unter www.DigiTrak.com/patents. 

Beschränkte Garantie 

Alle von Digital Control Incorporated (DCI) hergestellten und verkauften Produkte unterliegen den 
Bedingungen einer beschränkten Garantie. Dieses Handbuch enthält als Anhang eine Kopie der 
beschränkten Garantie. Sie können diese aber auch beim DCI Kundendienst unter der Nummer 
49.9391.810.6100 oder 1.425.251.0559 (USA) anfordern oder über die DCI-Website www.DigiTrak.com 
einsehen. 

Wichtiger Hinweis 

Alle Aussagen, technischen Angaben und Empfehlungen im Zusammenhang mit Produkten von DCI 
stützen sich auf Informationen, die nach bestem Wissen zuverlässig sind. DCI gewährleistet bzw. 
garantiert jedoch weder die Richtigkeit noch die Vollständigkeit solcher Angaben. Vor dem Einsatz 
eines DCI-Produkts muss der Benutzer dessen Eignung für die beabsichtigte Anwendung prüfen. Alle in 
dieser Bedienungsanleitung enthaltenen Aussagen beziehen sich auf DCI-Produkte in ihrem von DCI 
gelieferten Zustand für die Verwendung beim gewöhnlichen Horizontal-Richtbohren und gelten nicht für 
vom Anwender vorgenommene Veränderungen, Fremdprodukte oder die nicht bestimmungsgemäße 
Verwendung des DCI-Produkts. Keine der Aussagen in dieser Bedienungsanleitung stellt eine Garantie 
durch DCI dar oder kann als Abänderung der Bedingungen der für alle DCI-Produkte geltenden 
beschränkten Garantie angesehen werden. DCI behält sich vor, die Angaben in dieser 
Bedienungsanleitung von Zeit zu Zeit zu aktualisieren oder zu korrigieren. Die neueste Version dieser 
Anleitung ist auf der DCI-Website, www.DigiTrak.com zu finden. Klicken Sie unter Service & Support 
(Kundendienst), auf Documentation (Dokumentation) und wählen Sie die gewünschte Anleitung aus 
dem Drop-Down-Menü Manuals (Bedienungsanleitungen). 

Einhaltung der Richtlinien 

Dieses Gerät entspricht Teil 15 der FCC-Richtlinien, erfüllt die Bedingungen für die Lizenzbefreiung 
gemäß den RSS-Standards von Industry Canada und entspricht der Australia Class License 2000 für 
Geräte mit geringem Störungspotential. Der Betrieb unterliegt den folgenden zwei Bedingungen: (1) 
Dieses Gerät darf keine schädlichen Signalstörungen verursachen, und (2) dieses Gerät muss alle 
empfangenen Störungen aufnehmen, einschließlich Signalstörungen, die unerwünschtes 
Betriebsverhalten verursachen können. DCI ist für die Einhaltung der FCC-Richtlinien in den USA 
verantwortlich: Digital Control Incorporated, 19625 62nd Ave S, Suite B103, Kent WA 98032, USA; 
Telefon 1.425.251.0559 oder 1.800.288.3610 (nur in USA und Kanada). 

Änderungen an beliebigen DCI-Geräten, die nicht ausdrücklich von DCI genehmigt und ausgeführt 
wurden, machen die beschränkte Garantie des Benutzers und die FCC-Autorisierung zum Betrieb der 
Geräte ungültig. 

CE-Anforderungen 

  DigiTrak-Ortungsgeräte sind als Funkgeräte der Klasse 2 gemäß der R&TTE-Richtlinie 
eingestuft und ihr Betrieb ist in manchen Ländern möglicherweise illegal bzw. setzt eine Benutzerlizenz 
voraus. Die Liste der Einschränkungen und die erforderlichen Konformitätserklärungen finden sich auf 
der DCI-Website, www.DigiTrak.com. Klicken Sie unter Service & Support (Kundendienst), auf 
Documentation (Dokumentation) und wählen Sie das gewünschte Dokument aus dem Drop-Down-
Menü CE Documents (CE-Dokumente). 

http://www.digitrak.com/patents
http://www.digitrak.com/
http://www.digitrak.com/
http://www.digitrak.com/
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Kontakt 

Vereinigte Staaten 

DCI-Hauptsitz 

19625 62nd Ave S, Suite B103 

Kent, Washington 98032, USA 

+1.425.251.0559 / 1.800.288.3610 

+1.425.251.0702 fax 

dci@digital-control.com 

Australien 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 Fax 

dci.australia@digital-control.com 

China 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, Volksrepublik China 

+86.21.6432.5186 

+86.21.6432.5187 Fax 

dci.china@digital-control.com 

Europa Brueckenstraße 2 

97828 Marktheidenfeld 

Deutschland 

+49.9391.810.6100 

+49.9391.810.6109 Fax 

dci.europe@digital-control.com 

Indien DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 Fax 

dci.india@digital-control.com 

Russland Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Russia 121467 

+7.499.281.8177 

+7.499.281.8166 Fax 

dci.russia@digital-control.com 
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Lieber Kunde, 

Danke, dass Sie sich für ein DigiTrak-Ortungssystem entschieden haben. Wir sind äußerst 
stolz auf die Geräte, die wir seit 1990 im US-Staat Washington entwickeln und bauen. Wir 
bieten ein einzigartiges Produkt von höchster Qualität sowie überlegenen Kundendienst und 
ausgezeichnete Schulung.  

Bitte nehmen Sie sich die Zeit, die ganze Anleitung zu lesen – insbesondere den Abschnitt 
zur Sicherheit. Registrieren Sie bitte außerdem ihr Gerät online unter access.DigiTrak.com. 
Oder füllen Sie die diesem Gerät beiliegende Produktregistrierungskarte aus und schicken 
Sie sie per Fax an 1.253.395.2800 oder per Post an den DCI Hauptsitz. 

Mit der Produktregistrierung erhalten Sie die Berechtigung zu kostenlosem Telefon-Support 
(in den USA und Kanada), erhalten Informationen zu Aktualisierungen von Produkt und 
Anleitungen und helfen uns, Sie mit Informationen zu Produkt-Upgrades auf dem Laufenden 
zu halten. 

Falls Sie irgendwelche Probleme oder Fragen haben, können Sie sich gerne jederzeit an uns 
wenden. Unsere Kundendienstabteilung ist rund um die Uhr an 7 Tagen die Woche für Sie 
erreichbar. Sie finden internationale Kontaktangaben auf unserer Website. 

Mit wachsender Horizontal-Richtbohrbranche behalten wir die Zukunft im Auge, um Geräte 
zu entwickeln, die Sie Ihre Arbeit schneller und einfacher erledigen lassen. Schauen Sie 
jederzeit online bei uns vorbei, um zu sehen, was es Neues gibt. 

Wir freuen uns über Ihre Fragen, Kommentare und Ideen. 

Digital Control Incorporated 
Kent, Washington, USA 
2015 

 

Siehe unsere DigiTrak-Schulungsvideos unter www.youtube.com/dcikent 

 

file://///DCI-FS01/Shared%20Documents/Document%20Library/_In%20Dev/403-3300%20F5%20DataLog-LWD%20OM/English/access.DigiTrak.com
http://www.youtube.com/dcikent
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BESCHRÄNKTE GARANTIE 

 

Wichtige Sicherheitsanweisungen 

Betreiben Sie das DigiTrak-Ortungssystem stets sachgemäß, um genaue Daten zu Tiefe, 
Neigung, und Verrollung sowie genaue Ortungspunkte zu erhalten. Bei Fragen zur 
Bedienung des Systems wenden Sie sich bitte an den DCI-Kundendienst. 

Diese Bedienungsanleitung ergänzt die Bedienungsanleitung für Ihr Ortungssystem. Diese 
enthält eine umfassendere Liste von Warnhinweisen betreffend das Potential für schwere 
und tödliche Verletzungen, Arbeitsverzögerungen, Sachschäden sowie andere Gefahren und 
Warnhinweise betreffend den Betrieb von Horizontal-Richtbohrausrüstung. Bitte lesen und 
verstehen Sie die ganze Bedienungsanleitung des Systems, bevor Sie die in dieser Anleitung 
beschriebenen Geräte betreiben. 
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Einleitung 

      

Bohr- und Druckdaten in DataLog; F5- und Eclipse-Ortungsgerät 

Mit dem DigiTrak
 
DataLog-System können Bohrdaten mit einem F5- oder Eclipse-

Ortungsgerät (Empfänger) erfasst und gespeichert werden und dann mit der DCI Log-While-
Drilling (Aufzeichnung während des Bohrens) (LWD™)-Software auf einen Computer 
hochgeladen und analysiert werden. Das DataLog-System kann Folgende Arten von Daten 
messen und aufzeichnen:  

 Tiefe 

 Neigung 

 Höhenänderung (Oberflächentopographie) 

 Spülungsdruck (erfordert einen F5-Spülungsdrucksender) 

 Zugkraft und Spülungsdruck (erfordert einen TensiTrak-Sender) 

 Richtungsangaben für den Sender (erfordert einen SST 
Steering Tool Transmitter) 

Diese Bedienungsanleitung behandelt die DataLog-Funktion hauptsächlich für ein F5-
Ortungsgerät. Es sind zwar einige Anweisungen für das Eclipse-System enthalten, Eclipse-
Anwender werden jedoch auf die auf der DCI-Website erhältliche Bedienungsanleitung zum 
DigiTrak Eclipse DataLog-Kartierungssystem verwiesen. 

Wie oben erwähnt, funktioniert das DataLog-System mit TensiTrak- und SST-Sendern. Sie 
finden vollständige Angaben zum TensiTrak-Sender und zum SST-Ansteuerungssystem in 
der jeweiligen Bedienungsanleitung, die unter www.DigiTrak.com erhältlich sind. 

Die in dieser Bedienungsanleitung verwendeten Begriffe und Verfahren werden für die 
DigiTrak F5- und Eclipse-Ortungssysteme als grundlegend erachtet. Lesen und verstehen 
Sie die Bedienungsanleitung Ihres Systems und machen Sie sich mit den verschiedenen 
DataLog-Menüs am Ortungsgerät vertraut, bevor Sie das System für einen Rohreinzug 
einsetzen. Falls Sie Fragen haben, wenden Sie sich bitte telefonisch an die 
Kundendienstabteilung von DCI. 

Uhrzeit und Kalender einstellen 

Vor dem Aufzeichnen von Daten müssen die richtige Uhrzeit und das richtige Datum im F5-
Ortungsgerät programmiert werden. Die Option zum Einstellen von Uhrzeit und Datum 
befindet sich unter der Option "Settings" (Einstellungen) im Hauptmenü. Sie finden Hilfe zum 
Einstellen von Uhrzeit und Datum an Ihrem Ortungsgerät in der Bedienungsanleitung. 

http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/


DIGITAL CONTROL INCORPORATED 

2 DigiTrak DataLog/LWD™ Bedienungsanleitung 

Systemkomponenten 

Das DigiTrak DataLog-System hat vier Hauptkomponenten: 

F5- oder 
Eclipse-Ortungsgerät Ein Ortungsgerät (Empfänger) mit DataLog-Menüs zum Anzeigen und 

Aufzeichnen von Senderdaten. 

F5-, F Series- oder  
Eclipse-Sender Ein über Batterie oder Kabel mit Strom versorgtes Gerät im Bohrkopf, 

mit Sensoren, die kontinuierlich Daten zum unterirdischen Bohrkopf 
bzw. der Produkteinzugskraft messen und senden. Die Daten werden 
auf dem F5-Ortungsgerät angezeigt. 

LWD-Software Das Computerprogramm zum Herunterladen und Arbeiten mit DataLog-

Bohrdaten von einem Ortungsgerät. 

Upload-Adapter Ein USB-Gerät, das der Computer benötigt, um Daten von einem F5-

Ortungsgerät herunterzuladen bzw. ein serielles Infrarot-Kabelgerät 
zum Herunterladen von Daten von einem Eclipse-Ortungsgerät. 

Ortungsgerät 

Das Ortungsgerät verfolgt die Lage und Tiefe des Senders und zeichnet Bohr- und 
Zugkraftdaten auf. Das F5-Ortungsgerät kann pro Art von DataLog-Datei Bohr- bzw. Druck-
Zugkraftdaten von 50 Jobs (Durchläufen) aufzeichnen und speichern, bevor alle oder einige 
Jobs gelöscht oder auf einen Computer hochgeladen werden müssen, um Platz für neue 
Jobs zu schaffen. Jeder Bohrdatenjob kann Hunderte von Datenpunkten umfassen. Die 
Anzahl der Datenpunkte, die für jeden Druck-Zugkraft-DataLog-Job gespeichert werden 
kann, hängt nur vom verfügbaren Speicherplatz im F5-Ortungsgerät ab. 

Eclipse: Diese Anleitung enthält Anweisungen zur Verwendung der DataLog-Funktionen mit 
einem F5-Ortungsgerät. Falls Sie mit einem Eclipse-Ortungsgerät arbeiten, lesen Sie bitte die 
auf unserer Website erhältliche Bedienungsanleitung für das DigiTrak Eclipse DataLog-
Kartierungssystem. 

Sender 

Die DataLog-Funktion zeichnet Senderdaten von allen batteriebetriebenen Sendern und 
Kabelsendern der Typen F5, F Series und Eclipse auf. Dazu gehören auch der F5 TensiTrak, 
der Messwerte zu Spülungsdruck und Produkteinzugskraft Produkteinzugskraft liefert sowie 
der SST-Steering Tool Transmitter, der ohne Gitter für Drahtleitungs-Richtungsführung sorgt. 

Die von einem Sender gelieferten Standardbohrdaten umfassen Tiefe und Neigung. Ein 
Spülungsdrucksender (FPT) liefert außerdem Messwerte zu durchschnittlichem, hohem und 
maximalem Spülungsdruck pro Stange. Um ein Protokoll mit sowohl Bohr- als auch 
Druckdaten zu erhalten, müssen ein Bohrdatenjob und ein Druck-Zugkraft(P-T)-Datenjob 
gleichzeitig aufgezeichnet werden, da in Druck-Zugkraft-Datendateien keine Tiefe und 
Neigung aufgezeichnet werden. 

Sender und Ortungsgerät müssen kompatibel sein, um Daten aufzeichnen zu können. Das 
F5-Ortungsgerät ist mit F5- und F Series-Sendern kompatibel (es sind regionale 
Anforderungen an die Kompatibilität zu beachten). Das Eclipse-Ortungsgerät ist nur mit 
Eclipse-Sendern kompatibel. 

http://www.digitrak.com/customerservice/downloads.html
http://www.digitrak.com/customerservice/downloads.html
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LWD­Software 

Die Log-While-Drilling (Aufzeichnung während des Bohrens, LWD™)-Software wird auf 
einem USB-Stick geliefert, der außerdem diese Bedienungsanleitung, die 
Bedienungsanleitung des Ortungssystems, Musterbohrdaten und Bluetooth-Treiber enthält. 

 

LWD-USB-Stick 

Für die Software wird ein Computer mit den folgenden Mindest-Systemspezifikationen 
benötigt: 

 Betriebssystem Microsoft
 
Windows

 
XP, Microsoft Windows Vista, Microsoft Windows 

7, oder Microsoft Windows 8 

 USB-Anschluss 

 Zeigevorrichtung (Maus) 

 Drucker (optional)  

Bluetooth USB-Adapter 

Der Bluetooth-USB-Adapter (Amp’ed RF Modell BT-210) wird in Ihren Computer 
eingesteckt, damit das Ortungsgerät Daten hochladen kann. Treiber für den Bluetooth-
Adapter befinden sich auf dem LWD-USB-Stick und müssen vor Gebrauch geladen werden; 
siehe LWD-Software installieren auf Seite 24. 

 

 

Bluetooth USB-Adapter 

Für Eclipse: Zum Hochladen von Daten von einem Eclipse-Ortungsgerät wird ein ACTiSYS 
Infrarot(IR)-Kabel benötigt. Legen Sie das IR-Lesegerät über den IR-Anschluss des 
Ortungsgeräts und schließen Sie den seriellen Stecker am Computer an. 

Falls Ihr Computer keinen seriellen Anschluss hat, verwenden Sie den mit dem IR-Kabel 
mitgelieferten Seriell-USB-Adapter. Der für diesen Adapter benötigte "Prolific"-Treiber 
befindet sich ebenfalls auf dem USB-Stick. 
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DataLog-Grundlagen 

Der standardmäßig vom Log-While-Drilling-Programm erzeugte Bericht hängt davon ab, was 
auf Ihrem Ortungsgerät aufgezeichnet wird. In den nachfolgenden Abschnitten werden die 
fünf Arten von Bericht beschrieben, die DataLog in Log-While-Drilling erstellen kann. 

Das Ortungsgerät zeichnet die meisten Senderdaten unter Verwendung eines Bohrdaten-
DataLog-Jobs auf. Spülungsdruck und TensiTrak-Zugkraft werden in einem Druck-Zugkraft-
DataLog-Job getrennt aufgezeichnet. Um beide Datensätze in einem Diagramm anzuzeigen, 
müssen die beiden Aufzeichnungen zeitgleich erfolgen. 

 

Hinweis Bevor ein Job gestartet, angehalten oder fortgeführt werden kann, muss die 
DataLog-Funktion aktiviert werden. Wählen Sie aus dem Hauptmenü 

Bohrdaten-DataLog  und/oder Druck-Zugkraft-DataLog , wählen sie 

das rote Deaktiviert… -Symbol, sodass es grün  (aktiviert) wird, 

und wählen Sie Beenden , um zum Hauptmenü zurückzukehren. 

Standard-Senderdaten 

Um Standard-Senderdaten, wie Stangennummer, Tiefe und Neigung aufzuzeichnen, starten 
Sie einen Bohrdaten-DataLog-Job (siehe Daten aufzeichnen auf Seite 10). Diese Daten 
werden im Log-While-Drilling (LWD)-Programm wie folgt dargestellt: 

 

Nur Bohrdaten 

Menüleiste 

Baustellen-

angaben 

Jobangaben 

Symbolleiste 

Diagramm-bereich 

Statusleiste 

Datenpunktliste 
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Standard-Senderdaten mit Spülungsdruck 

Wählen Sie im Senderauswahlbildschirm einen FPT-Sender. Wenn Sie den 
Ortungsbildschirm öffnen, fragt das Ortungsgerät automatisch, ob es einen P-T-Datalog-Job 
starten soll. Starten Sie den P-T-Job, kehren Sie zum Ortungsbildschirm zurück und halten 
Sie dann kurz den Auslöser gedrückt und bewegen Sie den Kippschalter nach rechts, um 
einen zeitgleichen Bohrdaten-DataLog-Job zu starten (siehe Daten aufzeichnen auf 
Seite 10). 

 

Bohrdaten mit Spülungsdruck 

Spülungsdruckdaten ohne Bohrdaten 

Um nur den Spülungsdruck aufzuzeichnen, starten Sie einen Druck-Zugkraft-Datalog-Job, 
wie im obenstehenden Abschnitt beschrieben, starten jedoch keinen zeitgleichen Bohrdaten-
Datalog-Job. Da keine Bohrstangendaten vorliegenden, mit denen die Druckdaten gepaart 
werden können, enthält das resultierende LWD-Diagramm nur rohe, zeitbasierte 
Spülungsdruckdaten. 

 

Nur Spülungsdruck 

Tiefe 

Spülungsdruck 
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TensiTrak-Zugkraft- und Spülungsdruckdaten 

Um während der Verwendung eines TensiTrak-Zugkraftsenders den Spülungsdruck und die 
Zugkraft aufzuzeichnen, starten Sie einen P-T-DataLog-Job. Da während des Einziehens des 
Produkts kein Pilotbohrungssender installiert ist, haben TensiTrak-Diagramme dasselbe 
gezackte Aussehen wie ein Spülungsdruckjob ohne Bohrdaten. 

 

TensiTrak-Zugkraft und Spülungsdruck ohne Bohrdaten 

Sie finden eine umfassende Erörterung der Verwendung und Aufzeichnung von Daten für 
einen TensiTrak-Sender in der TensiTrak-Bedienungsanleitung, die unter www.DigiTrak.com 
erhältlich ist.  

Druck 

Kraft 

http://www.digitrak.com/
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Steering Tool (SST)-Daten 

Beim Aufzeichnen von Höhe, Bohrpfadprofil und Kursabweichung nach links/rechts mit einem 
SST-Steering Tool Transmitter wird die DataLog-Funktion nicht verwendet. Statt dessen 
muss dazu während des Bohrens die LWD-Software live auf einem mit dem Bohrgerät 
verbundenen Laptop laufen. 

 

LWD-Steering Tool (SST)-Höhen- und Kursdaten  

Sie finden eine umfassende Erörterung der Verwendung und Aufzeichnung von Daten für 
einen SST-Sender in der SST-Bedienungsanleitung, die unter www.DigiTrak.com erhältlich 
ist. 

Zweidimensionale Ansicht 

der Bohrung 

Kursabweichung nach 

links/rechts (Draufsicht) 

http://www.digitrak.com/
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Ortungsgerät-DataLog-Menüs 

Gehen Sie im Hauptmenü des F5-Ortungsgeräts zwei Schritte nach unten, um die 

Menüoptionen Bohrdaten-DataLog  und Druck-Zugkraft (P-T)-DataLog  anzuzeigen. 

 

Hauptmenü des F5-Ortungsgeräts, zweiter Bildschirm 

Bohrdaten-DataLog-Menü 

Verwenden Sie das Bohrdaten-DataLog-Menü , um Pilotbohrungs-Bohrdaten 

aufzuzeichnen.  

 

Bohrdaten-DataLog-Menü 

Bohrdaten-DataLog 

Druck-Zugkraft (P-T)-

DataLog 

Beschreibung der 

markierten Option 

DataLog-Job(s) löschen 

Vermessungspunkt 

hinzufügen 

DataLog-Jobs anzeigen 

Bohrdaten-DataLog-Job einrichten 

Bohrdaten-DataLog-Job auf 

einen Computer hochladen 

Bohrdaten-DataLog-Funktion 
aktivieren/deaktivieren (grün, 

wenn aktiviert, rot, wenn 

deaktiviert) 
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Druck-Zugkraft (P-T)-DataLog-Menü 

Verwenden Sie das Druck-Zugkraft (P-T) DataLog-Menü , um den Spülungsdruck 
aufzuzeichnen. Wenn Sie den Ortungsbildschirm öffnen, fragt das Ortungsgerät automatisch, 
ob es einen P-T-Datalog-Job starten soll. 

 

Druck-Zugkraft (P-T)-DataLog-Menü 

Ein Bohrdaten-DataLog-Job zeichnet alle Senderdaten, außer dem Spülungsdruck auf. Ein 
P-T-DataLog-Job zeichnet Druck und TensiTrak-Zugkraft auf. Um Bohrdaten und P-T-Daten 
in einem Bericht zu sehen, müssen beide Jobs für eine Bohrung zeitgleich aufgezeichnet 
werden. Wenn ein Bohrdaten-DataLog hochgeladen wird, der zeitgleich mit einem P-T-
DataLog aufgezeichnet wurde, zeigt die LWD-Software automatisch die P-T-Daten mit den 
Bohrdaten an. 

P-T-DataLog-Funktion 
aktivieren/deaktivieren 
(grün, wenn aktiviert, rot, 

wenn deaktiviert) 

Beenden 

P-T-DataLog-Job auf einen 
Computer hochladen 

 

P-T-DataLog-Job(s) löschen 

Das "p" zeigt an, dass ein 
Spülungsdrucksender 

ausgewählt ist 
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Daten aufzeichnen  

Um Pilotbohrungs-Bohrdaten aufzuzeichnen, muss das Ortungsgerät Daten von einem 
einwandfrei kalibrierten Sender empfangen, wie in der Bedienungsanleitung des 
Ortungsgeräts beschrieben. 

Stellen Sie sicher, dass die Funktionen Bohrdaten-DataLog und Druck-Zugkraft-DataLog 
aktiviert sind, wie im Hinweis auf Seite 4 beschrieben. 

Neuen Job anlegen 

 

Hinweis Um Druck-Zugkraft-Daten in Ihrem Bohrdaten-DataLog aufzunehmen, 
wählen Sie im Senderauswahlbildschirm einen FPT-Sender und wechseln 
zum Ortungsbildschirm zurück. Dort fordert Sie das Ortungsgerät 
automatisch auf, einen P-T-DataLog-Job zu starten (siehe P-T-Daten 
aufzeichnen auf Seite 22). Fahren Sie, wenn Sie zum Ortungsbildschirm 
zurückgewechselt haben, wie unten beschrieben fort, um einen zeitgleichen 
Bohrdaten-DataLog-Job zu starten. 

1. Halten Sie im Ortungsbildschirm kurz den Auslöser gedrückt und bewegen Sie 
außerdem den Kippschalter nach rechts, um das Menü Bohrdaten-DataLog-
Aufzeichnung starten anzuzeigen.  

2. Wählen Sie Neuen Job anlegen . 

 

Menü "Bohrdaten-DataLog-Aufzeichnung starten" 

Neuen Job anlegen 
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3. Geben Sie die Länge der für diese Bohrung zu verwendende Bohrstange (Rohr) über 

das Tastenfeld ein und wählen Sie dann Enter , um sie als die 

Bohrstangenlänge einzustellen. 

 

Tastenfeld zum Eingeben der Rohrlänge (Bohrstangenlänge) 

Die Standard-Bohrstangenlänge beträgt 3,05 m. Das Ortungsgerät hat die letzte 
Bohrstangenlänge gespeichert. 

4. Der Eingabebildschirm für die erste Bohrstangenlänge erscheint mit einem 
Standardwert. Diese Länge wird automatisch als 70 % der Rohrlänge berechnet. Falls 

dies für Ihre Bohrung richtig ist, können Sie  wählen, um diesen Wert einzustellen 
und mit Schritt 5 fortfahren. 

 

Eingabebildschirm für die erste Bohrstangenlänge 

Enter 

Erste Bohrstangenlänge auf 

Standardwert einstellen  

Tastenfeld wählen, um einen 

anderen Wert einzugeben 

Erste Bohrstangenlänge 
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Hinweis Wenn der Bohrkopf aufgrund der Bohrkopfkonfiguration nicht so positioniert 
werden kann, dass sich die Schlitze halb über und halb unter dem Boden 
befinden (wie in den vorangehenden und folgenden Abbildungen gezeigt), 
können Sie dies später in LWD mit ihren hochgeladenen Bohrlochdaten 
immer noch abbilden, indem Sie Job Information (Jobangaben) (im Menü 
Edit (Bearbeiten)) und im Feld Rel. Elev. (Relative Elevation) At Entry 
(Relative Höhe am Eintritt) einen Wert eingeben. Geben Sie zum Beispiel, 
wenn sich die Gehäuseschlitze 1,2 m unter dem Boden befinden, einen Wert 
von -1,2 ein. Sie finden weitere Angaben zu diesem Thema in der Log-While-
Drilling-Software unter Vermessungspunkt-Höhenänderung auf Seite 32. 

Um einen anderen Wert für die erste Bohrstangenlänge zu berechnen, messen Sie von 
den Halteklammern bis zum oberen Ende der Stange, wenn der Bohrkopf für den 
ersten Datenpunkt positioniert ist. Die Schlitze im Gehäuse sollten sich für diese 
Messung halb über und halb unter dem Boden befinden (bzw., beim Bohren in eine 
Eintrittsgrube, in einer zum Boden parallelen Eben). Die Höhe am ersten Datenpunkt 
ist die Nullbezugshöhe und liegt normalerweise auf der Höhe der Bodenoberfläche. 

Wählen Sie das Tastenfeld, geben Sie den gewünschten Wert ein und wählen Sie 

Enter . 

 

 

Messen der ersten Stangenlänge 

Oberes Stangenende 

Gehäuseschlitze 

Erste Bohrstangenlänge  

Halteklammern 

Bohrwagen 

Nullhöhen-

Bezugslinie  

Geländeoberfläche 
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5. Beim Aufzeichnen des ersten Datenpunkts (Stange 0), ist nur die Option Nur Neigung 

aufzeichnen  verfügbar. Achten Sie darauf, dass das Ortungsgerät in Reichweite 
des Senders positioniert ist (es muss sich nicht über der Ortungslinie oder am vorderen 

Ortungspunkt befinden) und wählen Sie , um den Datenpunkt aufzuzeichnen. 

 

Optionen bei der Bohrdaten-DataLog-Aufzeichnung (Nur Neigung) 

Das Ortungsgerät piepst zweimal und wechselt zum Ortungsbildschirm zurück. 

6. Fahren Sie mit dem Bohrkopf bis zum Ende der ersten Stange und positionieren Sie 
das Ortungsgerät über der Ortungslinie (Locate Line, LL) oder dem vorderen 
Ortungspunkt (Front Locate Point, FLP). 

7. Halten Sie den Auslöser und bewegen Sie den Kippschalter einmal nach rechts, um 
das Menü "Bohrdaten-DataLog-Aufzeichnungsoptionen" anzuzeigen, in dem nun alle 
Optionen aktiviert sind. 

  

Bohrdaten-DataLog-Aufzeichnungsoptionen  

Nur Neigung aufzeichnen 

Tiefe/Neigung aufzeichnen Leere Stange aufzeichnen 

Nur Neigung aufzeichnen 
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8. Wählen Sie eine der folgenden Optionen: 

 Tiefe/Neigung aufzeichnen  aufzeichnen, um Angaben zu Tiefe und Neigung 
zu protokollieren. 

 Nur Neigung aufzeichnen , um nur die Neigung zu protokollieren, da das 
Ortungsgerät nicht über der LL oder dem FLP positioniert werden kann. Das ist 
auch beim Bohren unter Armierungseisen nützlich, die die Signalstärke verringern 
können, was zu falschen Topographiewerten im Diagramm führen kann. 

 Leere Stange aufzeichnen , wenn keine Daten vorliegen, da Sie das 
Ortungsgerät nicht in Reichweite des Senders positionieren können. 

Klicken Sie den Auslöser, um den zweiten Datenpunkt aufzuzeichnen (Stange 1). Das 
Ortungsgerät piepst mehrmals und wechselt zum Ortungsbildschirm zurück. 

9. Fahren Sie mit dem Bohren fort und zeichnen Sie durch Drücken des Auslösers und 
Bewegen des Kippschalters nach rechts Datenpunkte am Ende jeder gebohrten 
Stange auf. 

Teilstangen aufzeichnen 

Die DigiTrak Log-While-Drilling (LWD)-Computersoftware verlangt, dass Datenpunkte in 
gleichmäßigen Abständen aufgezeichnet werden, beispielsweise am Ende jeder Bohrstange. 
Beim Bohren mit langen Bohrstangen und/oder wenn erhebliche Neigungsänderungen 
stattfinden, kann es ratsam sein, Daten in Teilrohrintervallen aufzuzeichnen, um das 
Bohrprofil und Änderungen der Topographie genauer darstellen zu können. Die LWD-
Funktion kann Datenpunkte bei einem Viertel, der Hälfte, drei Vierteln und ganzer Rohrlänge 
aufzeichnen. Teilstangen können erst aufgezeichnet werden, nachdem Stange 1 (zweiter 
Datenpunkt) aufgezeichnet wurde. 

Zum Aufzeichnen einer Teilstange: 

1. Positionieren Sie das Ortungsgerät über dem FLP oder, wenn möglich, über dem 
Bohrkopf auf der LL.  

2. Halten Sie im Ortungsbildschirm den Auslöser gedrückt und bewegen Sie den 
Kippschalter einmal nach rechts, um den Bildschirm "Aufzeichnungsoptionen" 
anzuzeigen. 

  

Bohrdaten-DataLog-Aufzeichnungsoptionen (erster Bildschirm) 

Tiefe/Neigung aufzeichnen Leere Stange aufzeichnen 

Nur Neigung aufzeichnen 



DIGITAL  CONTROL  INCORPORATED  

DigiTrak DataLog/LWD ™ Bedienungsanleitung 15 

3. Bewegen Sie den Kippschalter nach unten und wählen Sie Daten einer Teilstange 

auf der zweiten Seite. 

  

Bohrdaten-DataLog-Aufzeichnungsoptionen (zweiter Bildschirm) 

4. Wählen Sie eine Teilstangenlänge.  

 

DataLog-Teilstangenbildschirm 

Die Anzeige wechselt zum ersten Aufzeichnungsoptionen-Bildschirm zurück, statt "Full 
rod" (Ganze Stange) erscheint jedoch für die Stangenlänge der Teilstangenwert (¼, ½, 
¾) oder "Finish rod" (Stange fertigstellen) (siehe Bild in Schritt 2). 

5. Wählen Sie die Option zum Aufzeichnen von Tiefe und Neigung (bzw. nur Neigung, 
wenn das Ortungsgerät nicht über der LL oder dem FLP positioniert werden kann) und 
klicken Sie den Auslöser, um den Datenpunkt aufzuzeichnen. Das Ortungsgerät piepst 
mehrmals und wechselt zum Ortungsbildschirm zurück. 

6. Zeichnen Sie einen weiteren Datenpunkt für die Teilstangenlänge oder das Ende der 
Stange auf. 

Wenn zuvor eine Teilstange aufgezeichnet wurde, erscheint die Option "Finish rod". 

Daten einer Teilstange 

Stangendaten 

anzeigen/löschen 

Stangenlänge (ganz, ¼, ½, ¾, 
oder fertigstellen, je nachdem, 

ob eine ganze oder eine 

Teilstange gewählt ist) 
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Job schließen oder unterbrechen 

Der Bohrdaten- und der P-T-Job müssen beide geschlossen werden, bevor sie hochgeladen 
werden können. Schließen Sie einen Bohrdaten-DataLog-Job nach dem Aufzeichnen des 
letzten Datenpunkts und Dokumentieren der letzten Stange.  

Sie können einen DataLog-Job auch unterbrechen, sodass er offen bleibt, während Sie 
zwischen Menüoptionen navigieren. Alle DataLog-Jobs werden automatisch geschlossen, 
wenn das Ortungsgerät ausschaltet. 

1. Bewegen Sie im Ortungsbildschirm den Kippschalter nach unten, um das Menü 
"DataLog-Aufzeichnung schließen/unterbrechen" zu öffnen. 
 
Wenn Bohrdaten und DataLog-Daten aufgezeichnet werden, wird zuerst das Menü 
"Bohrdaten-DataLog-Aufzeichnung schließen/unterbrechen" (in der untenstehenden 
Abbildung gezeigt) angezeigt, gefolgt vom Menü "P-T-Aufzeichnung 
schließen/unterbrechen". 

2. Wählen Sie Job schließen , um den DataLog-Job zu schließen. Der Job kann 
nun auf einen Computer hochgeladen (siehe Daten auf einen Computer hochladen auf 
Seite 24) oder später fortgeführt werden (siehe Bestehenden Job fortführen on 
page 17.). 
 
-ODER- 

Wählen Sie Job unterbrechen , um den Job offen zu halten. Wenn Sie zum 
Ortungsbildschirm zurückkehren: 

 Bohrdaten-DataLog: Der nächste Datenpunkt wird im selben Job aufgezeichnet. 

 P-T-DataLog: Die Aufzeichnung von Daten fährt automatisch fort. 

 

Menü "Bohrdaten-DataLog-Aufzeichnung schließen/unterbrechen" 
(gleiche Optionen wie P-T) 

Um Angaben zu Landschaftsmerkmalen oder Versorgungsleitungen mit den Bohrdaten zu 
speichern, müssen Tiefe, Beschreibung, Stangennummer und/oder Entfernung vom Eintritt 
für jeden Posten von Hand eingegeben werden. Fügen Sie diese Angaben später zu den 
Bohrdaten hinzu, wenn Sie die LWD-Software auf dem Computer anwenden. 

Job unterbrechen Job schließen 
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Hinweis Ein F5-Ortungsgerät kann insgesamt 50 Bohrdaten- und 50 P-T-Jobs 
speichern. Das Ortungsgerät zeigt bei 45 gespeicherten Jobs einen 
Warnhinweis an. Wenn Sie versuchen, mehr als 50 Jobs zu speichern, 
kehrt die Anzeige zum Menü "Aufzeichnung starten" zurück, wo sie mit 
der Aufzeichnung einen Job fortführen oder die Aufzeichnung beenden 
können. 

Bestehenden Job fortführen 

Wählen Sie Fortführen im Menü "Aufzeichnung starten", um Daten zu einem DataLog-Job 
hinzuzufügen, der geschlossen oder unterbrochen wurde. 

Wenn die P-T-DataLog-Funktion aktiviert ist und ein Sender mit Drucksensor im Einsatz ist, 
wird das Menü "PT-Aufzeichnung starten" jedes Mal angezeigt, wenn der 
Ortungsbildschirm aufgerufen wird. Mit diesem Menü können Sie einen neuen Job anlegen 
(Aufzeichnung starten) oder einen bestehenden Job fortführen. Dieses Menü ist für die 
Bohrdaten-DataLog-Funktion gleich. 

1. Halten Sie im Ortungsbildschirm den Auslöser gedrückt und bewegen Sie den 
Kippschalter einmal nach rechts. 

2. Wählen Sie Fortführen… . 

  

Menü "Bohrdaten-DataLog-Aufzeichnung starten" (gleiche Optionen wie für P-T) 

Bestehenden Job fortführen 
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3. Wählen Sie die Nummer des fortzuführenden Jobs. 

     

Beispiel einer DataLog-Jobliste 

4. Nur Bohrdaten-DataLog: Wählen Sie im Bildschirm "Bohrdaten-DataLog-
Aufzeichnungsoptionen" die entsprechende Option, um mit der Aufzeichnung von 
Datenpunkten fortzufahren. 

5. Fahren Sie mit der Aufzeichnung von Bohrstangen oder Teilstangen, wie zuvor in 
diesem Abschnitt beschrieben, fort.  
 
Die Aufzeichnung von P-T-Daten wird automatisch fortgesetzt. 

Stangen auf dem Ortungsgerät anzeigen und löschen 

1. Halten Sie im Ortungsbildschirm den Auslöser gedrückt und bewegen Sie den 
Kippschalter einmal nach rechts, um den Bildschirm "Aufzeichnungsoptionen" 
anzuzeigen. 

2. Bewegen Sie den Kippschalter nach unten und wählen Sie Stangendaten 

anzeigen/löschen . 

  

Bohrdaten-DataLog-Aufzeichnungsoptionen (Stangendaten anzeigen/löschen) 

Bohrdaten-DataLog-
Jobs sind mit "L" 
gekennzeichnet, 
Druck-Zugkraft-

DataLog-Jobs mit "PT" 

Stangendaten 

anzeigen/löschen 
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3. In der Stangendaten-Anzeigeliste sind die neuesten Stangendaten (die einzigen, die 
gelöscht werden können) in der obersten Zeile markiert. Klicken Sie, um sie 
auszuwählen (bewegen Sie den Kippschalter nach links oder rechts, um zum 
Ortungsbildschirm zurückzukehren, ohne den Datenpunkt zu löschen). 

  

Stangendaten-Anzeigeliste 

4. Wählen Sie , um den letzten Stangendatenpunkt zu löschen oder Beenden  

, um abzubrechen und zum Ortungsbildschirm zurückzukehren. 

  

Bildschirm "Stange löschen" 

5. Wiederholen Sie diese Schritte für jede zu löschende Stange. Wählen Sie dazu jeweils 

den letzten Datenpunkt aus der in Schritt 3 gezeigten Liste und dann , um ihn zu 
löschen. Bewegen Sie in der Stangendaten-Anzeigeliste den Kippschalter nach links 
oder rechts, wenn Sie mit dem Löschen von Stangen fertig sind, um zum 
Ortungsbildschirm zurückzukehren. Überprüfen Sie, ob die Anzahl der verwendeten 
Stangen mit der Stangendaten-Anzeigeliste übereinstimmt. 

Daten der zuletzt 

aufgezeichneten Stange 

Vermessungspunkt 
(erscheint leer, es sei denn, 
unter der Menüoption 
"Vermessungspunkt" wurde 

ein Wert eingetragen) 

Letzten Stangendatenpunkt 

löschen Beenden 
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Letzten Stange messen und dokumentieren (optional) 

Messen und dokumentieren Sie die Länge der letzten Stange, wenn der Bohrkopf aus dem 
Boden austritt, da dies nicht mit den Bohrdaten im Ortungsgerät aufgezeichnet wird. Geben 
Sie diesen Wert von Hand in der LWD-Software ein, nachdem der Job hochgeladen wurde. 

Die letzte Stangenlänge ist die Rohrlänge abzüglich der Länge der im Gestell verbleibenden 
Bohrstange. Wenn zum Beispiel die Rohrlänge 3,0 m beträgt und 1,8 m von den 
Halteklammern zum oberen Stangenende verbleiben, beträgt die letzte Stangenlänge  
3,0 m - 1,8 m = 1,2 m. 

 

Messung der letzten Stange 

Bohrdaten-DataLog-Vermessungspunkt hinzufügen 

Bei einem Höhenunterschied zwischen Eintritt und Austritt der Bohrung, kann es sinnvoll 
sein, einen Vermessungspunkt hinzuzufügen, um kumulierte Neigungsänderungen 
auszugleichen, die das Profildiagramm beeinflussen können. Das führt zu einem genaueren 
Diagramm der Bohrung und des Geländes in der LWD-Software. 

Wählen Sie im Hauptmenü die Option Bohrdaten-DataLog, dann Vermessungspunkt 
hinzufügen. Der Vermessungspunkt kann auch später, nach dem Hochladen der Daten in 
der Log-While-Drilling-Software eingegeben werden (siehe Vermessungspunkt-
Höhenänderung auf Seite 32). 

1. Wählen Sie im Bohrdaten-DataLog-Menü  Vermessungspunkt hinzufügen . 

2. Wählen Sie aus der angezeigten Liste bestehender Bohrjobs den Job, zu dem der 
Vermessungspunkt hinzugefügt werden soll. 

Halteklammern 

Bohrstangen 

Gehäuse-

schlitze 

1,8 m Stangenlänge verbleiben im Gestell 
Geländeoberfläche 

(Topographie) 

Nullhöhen-

Bezugslinie 

Bohrkopf 

Austritt 

Rohrlänge  

(3,0 m) 

Bohr-
gerät 

Oberes Stangenende 



DIGITAL  CONTROL  INCORPORATED  

DigiTrak DataLog/LWD ™ Bedienungsanleitung 21 

3. Wählen Sie das Tastenfeld. 

  

Vermessungspunktmenü 

4. Verwenden Sie das Tastenfeld auf dem Bildschirm, um den vermessenen Wert für den 
Höhenunterschied zwischen Eintritt und Austritt der Bohrung einzugeben. 

Dieses Tastenfeld enthält eine "+/-"-Taste, da der Höhenunterschied positiv oder 
negativ sein kann. Das Tastenfeld geht davon aus, dass der Wert positiv ist, d.h., dass 
der Austritt höher liegt als der Eintritt. Ändern Sie dies ggf. mit der "+/-"-Taste. 

5. Wählen Sie Enter , um die angezeigten Werte als den Wert des 
Vermessungspunkts einzustellen. Der Bildschirm wechselt zum DataLog-Menü zurück. 

 

Hinweis Ein Vermessungspunkt kann später in der Log-While-Drilling-Software zu 
dem Job hinzugefügt werden. Siehe Vermessungspunkt-Höhenänderung auf 
Seite 32.  

Vermessungspunkt auf 
"unbekannt" zurücksetzen (die 

LWD-Software berechnet den 

Höhenunterschied) 

Tastenfeld öffnen, um 
bekannten Höhenunterschied 

einzugeben 
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P-T-Daten aufzeichnen 

Wählen Sie im Senderauswahlbildschirm einen FPT-Sender. Wenn Sie dann den 
Ortungsbildschirm aufrufen, fordert das Ortungsgerät Sie automatisch auf, einen Druck-
Zugkraft (P-T)-DataLog-Job anzulegen. 

Mit Bohrdaten aufzeichnen 

1. Wählen Sie im Menü "P-T-DataLog-Aufzeichnung starten" Neuen Job anlegen . 
Die Nummer des neuen Jobs wird unten im Bildschirm angezeigt. 

  

Menü "P-T-DataLog-Aufzeichnung starten" 

Das Ortungsgerät wechselt zum Ortungsbildschirm zurück und die Aufzeichnung von P-T-
Daten beginnt, wie durch das Aufzeichnungssymbol neben der Verrollungsanzeige 
angezeigt. 

  

P-T-Datenaufzeichnungssymbol 

Halten Sie im Ortungsbildschirm kurz den Auslöser gedrückt und bewegen Sie den 
Kippschalter nach rechts, um einen zeitgleichen Bohrdaten-DataLog-Job zu starten (siehe 
Daten aufzeichnen auf Seite 10). 

Neuen Job anlegen (öffnet den 
Ortungsbildschirm, Daten werden 
unter der angezeigten Jobnummer 

aufgezeichnet) 

Beenden (wechselt zum 
Ortungsbildschirm zurück, es 

werden keine Daten aufgezeichnet) 
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Ohne Bohrdaten aufzeichnen 

Starten Sie, um nur Druck-Zugkraft-Daten aufzuzeichnen, einen P-T-DataLog-Job wie im 
vorangehenden Abschnitt beschrieben, aber starten Sie keinen zeitgleichen Bohrdaten-
DataLog-Job, wenn Sie zum Ortungsbildschirm zurückkehren. 

Da keine Bohrstangendaten aufgezeichnet werden, zeigt das resultierende LWD-Diagramm 
nur rohe, zeitbasierte Spülungsdruckdaten. 

Daten-Flags setzen 

Verwenden Sie Daten-Flags nur mit TensiTrak oder beim Aufzeichnen des Spülungsdrucks 
ohne zeitgleichen Bohrdaten-DataLog. Daten-Flags helfen, Datenpunkte einer bestimmten 
Stelle entlang dem Bohrpfad zuzuordnen. 

Das Flag-Aufzeichnungsmenü ist nur verfügbar, wenn bereits ein P-T-Job läuft und auf dem 
Ortungsgerät der Ortungsbildschirm angezeigt wird. DCI empfiehlt das Aufzeichnen von 
Flags an bedeutenden Stellen entlang dem Bohrpfad, wie etwa vor und nach dem 
Unterqueren einer Straße oder eines Bachs, um das Zuordnen physischer Orte entlang dem 
Bohr-/Einziehpfad zu den Datenpunkten in der P-T-Datei zu erleichtern. 

1. Bewegen Sie im Ortungsbildschirm den Kippschalter nach rechts, um das Flag-
Aufzeichnungsmenü anzuzeigen. 

  

DataLog-Flag-Aufzeichnungsmenü 

2. Wählen Sie Flag setzen , um einen Flag aufzuzeichnen. Ein einmal 
aufgezeichneter Flag kann nicht aus der P-T-Datendatei gelöscht werden. 

3. Notieren Sie sich Flag-Nummern und Angaben zu den Orten, an denen jeder Flag 
aufgezeichnet wurde, wie etwa "Eintritt unter Straße" oder "entferntes Bachufer". 
Fügen Sie diese Angaben nach dem Hochladen auf den Computer zur P-T-Datendatei 
hinzu. 

Einen Flag setzen (zeichnet die 
auf dem Ortungsbildschirm 

angezeigte Flag-Nummer auf) 

Beenden (wechselt ohne 
Aufzeichnen eines Flags zum 

Ortungsbildschirm zurück) 
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LWD-Software installieren 

Die Mindestsystemanforderungen für die Verwendung von LWD-Software auf einem 
Computer sind auf Seite 3 zu finden. 

Die LWD-Programmdateien werden standardmäßig im Verzeichnis 
C:\Programme\DCI\DigiTrak LWD abgelegt. Die LWD-Datendateien und Musterdatendateien 
werden automatisch unter Eigene Dateien\DCI abgelegt. Sie können diese 
Standardverzeichnisse bei der Installation ändern. 

1. Schließen Sie alle offenen Programme.  

2. Stecken Sie den LWD-Stick in eine USB-Buchse und zeigen Sie den Inhalt des Sticks 
an. 

3. Öffnen Sie den Ordner "LWD Kit" und doppelklicken Sie auf Drivers for LWD (Treiber 
für LWD), um Treiber zu installieren. 

4. Öffnen Sie den Ordner "Bluetooth drivers" und doppelklicken Sie auf die *.exe-Datei, 
um Bluetooth-Treiber zu installieren (falls Sie keine Dateierweiterungen wie .exe 
sehen, doppelklicken Sie auf die Datei vom Typ Programm). 

5. Öffnen Sie den Ordner "DigiTrak LWD Software" und doppelklicken Sie auf die Setup-
Datei (setup.exe), um die LWD-Software zu installieren. 

Nachdem diese Treiber und Software installiert sind, wird das LWD-Verknüpfungssymbol 

 auf dem Desktop angezeigt. 

Daten auf einen Computer hochladen 

Um DataLog-Jobs vom F5-Ortungsgerät auf den Computer hochzuladen, muss das F5-
Ortungsgerät zur Bluetooth-Geräteliste der LWD Software hinzugefügt werden, dann können 
die Dateien über die Bluetooth-Verbindung auf den Computer hochgeladen werden.  

Für Eclipse: Gehen Sie zu Daten von einem Eclipse-Ortungsgerät hochladen auf Seite 26. 

F5-Ortungsgerät zur LWD Bluetooth-Geräteliste 
hinzufügen 

Vor der ersten Verwendung muss in der LWD-Software ein F5-Ortungsgerät zur Bluetooth-
Geräteliste hinzugefügt werden. 

1. Schalten Sie den Computer ein und stecken Sie den Bluetooth USB-Adapter (Amp’ed 
RF Modell BT-210) in eine USB-Buchse. 

2. Schalten das F5-Ortungsgerät ein und wählen Sie Systeminformationen  aus 

dem Hauptmenü. 



DIGITAL  CONTROL  INCORPORATED  

DigiTrak DataLog/LWD ™ Bedienungsanleitung 25 

3. Lassen Sie diesen Bildschirm offen oder notieren Sie die Ortungsgerät-ID und die 
Bluetooth-Geräteadresse. 

  

Systeminformationsbildschirm des Ortungsgeräts 

4. Öffnen Sie die LWD-Software mit einem Doppelklick auf das LWD-Symbol  auf 
dem Desktop. 

5. Klicken Sie auf Bluetooth  (Menüs View > Bluetooth Device List (Ansicht > 
Bluetooth-Geräteliste)), um das Dialogfeld "Bluetooth Device List" (Bluetooth-
Geräteliste) zu öffnen. 

6. Geben Sie im Feld Bluetooth Device Address die Bluetooth-Geräteadresse ein. 

  

Dialogfeld "Bluetooth-Geräteliste" 

7. Geben Sie im Feld Bluetooth Device Name (Bluetooth-Gerätebezeichnung) die 
Ortungsgerät-ID ein. 

8. Klicken sie auf Add (Hinzufügen). 

9. Klicken Sie auf OK. Das Gerät erscheint in der Bluetooth-Geräteliste. 

Jetzt können Job-Daten hochgeladen werden. 

Bluetooth-

Geräteadresse Ortungsgerät-ID 
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Daten vom F5-Ortungsgerät hochladen  

DCI empfiehlt, Daten nach jedem DataLog-Job auf einen Computer hochzuladen. 

1. Öffnen Sie das DataLog-Menü für den Typ der Jobdatei, die Sie hochladen: Bohrdaten 

 oder Druck-Zugkraft . 

2. Wählen Sie Job hochladen . 

3. Wählen Sie den hochzuladenden Job. 

 

Hinweis Die Daten müssen innerhalb von 15 Minuten zum Computer übertragen 
werden, da sonst das Ortungsgerät infolge Untätigkeit ausschaltet. 

4. Öffnen Sie die LWD-Software mit einem Doppelklick auf das LWD-Symbol  auf 
dem Desktop. 

5. Klicken Sie auf Neu  (Menüs File > New (Datei > Neu)). 

6. Wählen Sie den hochzuladenden Dateityp (Bohrdaten oder Druck-Zugkraft) und klicken 
Sie auf OK. 

7. Klicken Sie im leeren Formular, das nun angezeigt wird auf Verbindung  (Menüs 
File > Upload Control (Datei > Upload-Steuerung)). 

8. Wählen Sie im Dialogfeld "Upload Control" Bluetooth. 

9. Wählen Sie in der Drop-Down-Liste Serial Port Connection (Verbindung über 
seriellen Anschluss) Silicon Labs CP210x USB to UART Bridge (COM#). 

10. Wählen Sie die Bezeichnung Ihres Ortungsgeräts aus der Bluetooth-Drop-Down-Liste. 

11. Klicken Sie auf die Schaltfläche Connect to Device (Verbindung zu Gerät herstellen), 
um mit dem Upload zu beginnen. 

12. Nachdem die Daten übertragen wurden, erscheint das Dialogfeld "DataLog Job 
Information" (DataLog-Jobangaben). Sie können die erforderlichen Angaben jetzt oder 
später eingeben. 

13. Klicken Sie auf OK. 

Die neuen Jobdaten werden in den Informationsfeldern und Diagrammbereichen im LWD-
Programmfenster angezeigt. 

Daten von einem Eclipse-Ortungsgerät hochladen 

Zum Hochladen von Daten von einem Eclipse-Ortungsgerät wird das mit dem Eclipse 
DataLog-System mitgelieferte ACTiSYS IR-Kabel und, falls Ihr Computer keinen seriellen 
Anschluss hat, der Seriell-USB-Adapter benötigt. 

1. Stecken Sie das ACTiSYS IR-Kabel in den seriellen Anschluss (COM) an Ihrem 
Computer (bzw. den USB-Anschluss, wenn Sie den Seriell-USB-Adapter verwenden). 

2. Schalten Sie Computer und Ortungsgerät ein. 

3. Öffnen Sie die LWD-Software mit einem Doppelklick auf das LWD-Symbol  auf 
dem Desktop. 
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4. Klicken Sie auf Neu  (Menüs File > New (Datei > Neu)). 

5. Wählen Sie den hochzuladenden Dateityp (Bohrdaten oder Druck-Zugkraft) und klicken 
Sie auf OK. 

6. Klicken Sie im leeren Formular, das nun angezeigt wird auf Verbindung  (Menüs 
File > Upload Control (Datei > Upload-Steuerung)). 

7. Wählen Sie im Dialogfeld "Upload Control" Infra-Red (Infrarot). 

8. Wählen Sie in der Drop-Down-Liste "Serial Port Connection" (Verbindung über 
seriellen Anschluss) den dem IR-Kabel zugewiesenen Kommunikationsanschluss 
(COM). 

9. Bewegen Sie im Hauptmenü den Kippschalter nach rechts bewegt und wählen Sie 
DataLog. 

10. Wählen Sie Send Data (Daten senden). 

11. Das Ortungsgerät zeigt den zuletzt aufgezeichneten Job an. Wählen Sie den richtigen 
hochzuladenden Job. 

12. Richten Sie das IR-Lesegerät am Ende des Kabels mit dem roten IR-Anschluss links 
vom Anzeigefenster des Ortungsgeräts aus und klicken Sie dann den Auslöser, um mit 
dem Upload zu beginnen. 

Bei erfolgreichem Upload erscheinen die Bohrdaten sofort auf dem Computerbildschirm. 

Empfehlungen zum Hochladen 

DCI empfiehlt, Daten für jeden Durchlauf zweimal hochzuladen und jeweils unter einem 
anderen Namen zu speichern. So wird sichergestellt, dass unabhängig davon, wie viele 
Änderungen Sie in LWD in der Datei vornehmen, Sie immer eine Originalkopie als Sicherung 
haben. 

Wenn Sie einen Datenpunkt mit der Option "nur Neigung" oder "leere Stange" aufgezeichnet 
haben, betrachtet LWD die Daten für diesen Datenpunkt als fehlende. Die LWD-Software trifft 
Annahmen zum Ergänzen der fehlenden Daten oder Sie können eigene Daten eingeben. 
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DataLog-Job löschen 

1. Wählen Sie im Bohrdaten-DataLog-Menü  DataLog-Job löschen . 

2. Wählen Sie die entsprechende Schaltfläche, um einen  oder alle  Jobs zu 
löschen. 

   

Menü "DataLog-Jobs löschen" 

3. Wählen Sie zum Löschen eines Jobs diesen in der Liste verfügbarer Bohrdaten- und  
P-T-DataLog-Jobs aus. 

4. Wählen Sie im Bestätigungsbildschirm Bestätigen , um zu löschen oder 

Beenden , um abzubrechen. 

 

Bildschirm "Löschen des Jobs bestätigen" 

Gelöschte Jobs können nicht wiederhergestellt werden. Stellen Sie sicher, dass Jobs, die Sie 
speichern möchten, auf einen Computer hochgeladen wurden, bevor Sie sie vom 
Ortungsgerät löschen. 

 

Einen Job löschen 

Alle Jobs löschen 

Beenden, ohne einen 

Job zu löschen 

Löschen des Jobs 

bestätigen 
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LWD anwenden 

LWD-Programm starten und Dateien öffnen 

Starten Sie das Log-While-Drilling (Aufzeichnung während des Bohrens, LWD™)-Programm 

durch doppelklicken des LWD-Symbols  auf dem Desktop. Klicken Sie auf Neu  
(Menüs File > New (Datei > Neu)), um eine neue DataLog Job-Datei anzulegen und wählen 
Sie den Typ der anzulegenden Job-Datei: Bohrdaten, Druck-Zugkraft oder Ansteuern. 

Ein neues Bohrdatenformular ist leer; ein LWD-Formular mit Daten sieht so aus: 

 

LWD-Bohrdatenfenster 

Klicken Sie auf Öffnen  (Menüs File > Open (Datei > Öffnen)), um eine vorhandene 
DataLog-Datei zu öffnen. Sie können eine DataLog-Datei auch direkt aus Windows Explorer 
öffnen, indem Sie auf eine *.dl5 Bohrdaten-DataLog- oder *.tt5 Druck-Zugkraft-Datei 
doppelklicken. 

In den LWD-Hilfemenüs finden Sie hilfreiche Angaben zum Programm. In den unter Hilfe  
einsehbaren Dateien finden Sie ausführliche Angaben zum Lesen und Bearbeiten der 

Datenfelder. Mit dem Tooltip-Helfer  können Sie auf ein Bildschirmelement klicken, um 
Hilfe zur entsprechenden Funktion anzuzeigen.  

Viele LWD-Menübefehle sind denen in anderen Windows-Programmen ähnlich und einige 
von ihnen haben entsprechende Symbole in der Symbolleiste. Zeigen Sie mit dem Cursor auf 
ein beliebiges Symbol in LWD, um einen seine Funktion beschreibenden Tooltip anzuzeigen. 
Hellgrau angezeigte Symbole oder Menüoptionen sind für den aktuellen DataLog-Dateityp 
nicht verfügbar. Unter Anhang B – Menü auf Seite 50 finden Sie eine Liste aller 
Menüoptionen und den entsprechenden Symbolleisten-Schaltflächen. Klicken Sie zum 

Beispiel auf Anzeigeeinheiten  (Menüs Edit > Display Units (Bearbeiten > 
Anzeigeeinheiten), um für die die Maßeinheiten zwischen Dezimalfuß (ft.) und Metern (m) zu 
wechseln. 

Menüleiste 

Baustellenangaben 

Jobangaben 

Symbolleiste 

Diagrammbereich 

Statusleiste 

Datenpunktliste 
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Komponenten eines LWD-Bildschirms 

Baustellenangaben  

Klicken Sie auf Baustellenangaben  oder wählen Sie in den Menüs Edit > Site 
Information (Bearbeiten > Baustellenangaben) oder doppelklicken Sie auf den unten 
abgebildeten Bereich "Site Information", um diese Angaben zu bearbeiten. 

   

Baustellenangaben auf dem Bildschirm (links) und Dialogfeld 

Sämtliche Adress- und Kontaktangaben für den Job, Auftraggeber und Bauunternehmer 
werden im gedruckten Bericht aufgeführt (weitere Angaben finden Sie unter LWD-Jobs 
speichern, drucken und verschicken auf Seite 45). 
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Hinweis Die Baustellenangaben bleiben von Job zu Job erhalten, damit 
identische Daten nicht mehrmals eingegeben werden müssen. 
Manchmal werden diese Angaben nicht von Job zu Job übernommen, 
insbesondere bei Versionen nach Windows XP. Versuchen Sie in 
diesem Fall Folgendes: Beenden Sie LWD, klicken Sie mit der rechten 
Maustaste auf das LWD-Symbol auf dem Desktop, wählen Sie 
Properties (Eigenschaften), wählen Sie die Registerkarte 
Compatibility (Kompatibilität) aktivieren Sie das Kästchen "Run this 
program as an administrator" (Dieses Programm als Administrator 
ausführen) und klicken Sie dann auf OK. 

Jobangaben 

Klicken Sie auf Jobangaben  oder wählen Sie in den Menüs Edit > Job Information 
(Bearbeiten > Jobangaben) oder doppelklicken Sie auf den unten abgebildeten Bereich "Job 
Information", um diese Angaben zu bearbeiten. 

   

Jobangaben auf dem Bildschirm (links) und Dialogfeld 

Im Bereich "Jobangaben" werden statistische Angaben zum Job angezeigt. Manche Felder 
können nicht geändert werden. 

Date (Datum) Bei einem F5-Ortungsgerät entspricht das Datum dem ersten 

hochgeladenen Datenpunkt; bei einem Eclipse-Ortungsgerät ist es der 
Tag, an dem der Job hochgeladen wurde, bei importierten Eclipse-
Dateien ist es der Tag, an dem die Datei in das LWD-Programm 
importiert wurde. 

Serial Number (Seriennummer) ID- oder Seriennummer des Ortungsgeräts 

Job ID (Jobnummer) Dem Job im Ortungsgerät zugeordnete Nummer 

Data Points (Datenpunkte) Zahl der erfassten Datenpunkte (einschl. manuell 

eingefügter Daten) 

Typical/Default Rod 
Length (Typische/Standard-Stangelänge) Länge der verwendeten Stangen. 

Depth (Tiefe) Für die Tiefe verwendete Maßeinheiten - Fuß (ft.) oder Meter (m) 

Pitch (Neigung) Für die Neigung verwendete Maßeinheiten - Prozent (%) 

oder Grad (°) 

Pressure (Druck) Für Druck verwendete Maßeinheiten - Pfund pro Quadratzoll 

(psi) oder Kilopascal (kPa) (oben nicht abgebildet) 
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Entry (Eintritt) Eintrittsstelle relativ zu den Koordinaten (0, 0) in den 

Diagrammen (positive oder negative Entfernung im 
Profilansichtsdiagramm und Lage links (L) oder rechts (R) im 
Draufsichtsdiagramm) 

Angaben zur Stangenlänge 

Typical/Default Rod 
Length (Typische/Standard-Stangenlänge) Angaben zur Stangenlänge sind in 

den Uploads vom F5-Ortungsgerät enthalten, können aber geändert 
werden, falls Sie am Ortungsgerät falsch eingegeben wurden.

1 

First Rod Length (Länge des ersten Stange) Die Stangelänge für den ersten Datenpunkt 

(Stange 0), bei der es sich normalerweise um eine Teilstange handelt. 
Dieser Wert wird durch Messen der im Gestell verbleibenden 
Bohrstange von der Halteklammer bis zum oberen Stangenende 
bestimmt, wenn die Stange 0 aufgezeichnet wird. 

Last Rod Length (Länge der letzten Stange) Die Stangenlänge für den letzten 

Datenpunkt, wobei es sich normalerweise um eine Teilstange handelt. 
Dieser Wert wird bestimmt, indem die Länge der im Gestell 
verbleibenden Bohrstange von der Halteklammer bis zum oberen 
Stangenende gemessen und dann von der Stangenlänge abgezogen 
wird. Wenn beispielsweise die Länge der im Gestell verbleibenden 
Stange 1,8 m beträgt und die Stangenlänge 3,0 m, misst die letzte 
Stange 1,2 m (3,0 m - 1,8 m = 1,2 m). 

Vermessungspunkt-Höhenänderung  

Do Not Use Reference  
Elevation (Keine Bezugshöhe verwenden) Aktivieren Sie das Kästchen, wenn 

Eintritt und Austritt auf derselben Höhe liegen. Wird dieses 
Kontrollkästchen deaktiviert, kann im Feld "Reference Elevation" 
(Bezugshöhe) darunter ein Wert eingegeben werden. 

Reference Elevation (Bezugshöhe) Die Höhe eines geographischen 

Bezugsvermessungspunkts in der Nähe der Bohrung. Aktiveren Sie das 
Kästchen Do Not Use Reference Elevation (Keine Bezugshöhe 

verwenden), um dieses Feld zu deaktivieren, falls keine Bezugshöhe 
benötigt wird. Die Geländeoberfläche an der Eintrittsstelle des 
Bohrkopfs wird als Bezugshöhe (Höhe Null) im Diagramm und in der 
Datenpunktliste verwendet. Wenn eine Bezugshöhe verwendet wird, 
wird ihr Wert zum Nullbezugspunkt im Diagramm und in der 
Datenpunktliste. 

Relative Elevation at Entry (Relative Höhe am Eintritt) Der vertikale Abstand von der Nullhöhen-

Bezugslinie zur Stelle, an der die Bohrung in den Boden eintritt. In den 
meisten Fällen ist der Eintritt an der Geländeoberfläche. Wenn eine 
Eintrittsgrube verwendet wird, liegt diese Stelle am Boden der Grube. 

                                                      

1
 Stellen Sie für Uploads von Eclipse-Ortungsgeräten die Standard-Stangenlängen ein, indem Sie auf die 

Schaltfläche "Set Defaults" (Standardwerte einstellen) klicken. Diese Einstellung wird dann für alle neuen Eclipse-
Uploads verwendet. An den Einstellungen einer einzelnen Datei vorgenommene Änderungen bleiben bei der 
gespeicherten Datei. 
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Do Not Use Exit  
Survey Point (Keinen Austritts-Vermessungspunkt verwenden) Aktivieren Sie dieses 

Kästchen, wenn zwischen Eintritt und Austritt kein Höhenunterschied 
besteht. Der Austritt wird dann nur basierend auf Neigungs-, Stangen- 
und Tiefendaten berechnet. 

Rel. Elev. at Exit (Relative Höhe am Austritt) Der positive oder negative Unterschied 

zwischen der Höhe am Eintritt und der am Austritt. Geben Sie einen 
negativen Wert ein, wenn der Austritt tiefer liegt als der Eintritt. 
Verwenden Sie für positive Werte kein  
+-Zeichen. Diese Angaben können mit dem F5-Ortungsgerät durch 
Einstellen als Vermessungspunkt erfasst werden. 

 

 

Hinweis Bei Verwendung einer Eintrittsgrube muss die Tiefe der Grube im Wert 
für Rel. Elev. At Entry berücksichtigt werden. Stange 0 muss 
bearbeitet werden, um die Tiefe der Grube unter der Bezugshöhe 
anzugeben. Bearbeiten Sie Stange 0, wenn keine Bezugshöhe 
verwendet wird, um die Tiefe der Grube als die relative Höhe am Eintritt 
anzugeben. 

Datenpunktliste 

Die Datenpunktliste ist eine Tabelle, die sämtliche Datenpunkte im Job anzeigt. In dieser 
Tabelle können Sie einzelne Datenpunkte einfügen, bearbeiten, löschen, ausblenden oder 
entfernen. Die in der Tabelle angezeigten Spalten hängen vom Typ der offenen DataLog-
Datei ab. Weitere Angaben finden Sie unter Komponenten eines LWD-Bildschirms auf Seite 
30 und Druck-Zugkraft-DataLog-Funktionen auf Seite 40. 

Diagrammbereich 

Der Diagrammbereich enthält eine graphische Darstellung der in der Datenpunktliste 
enthaltenen Daten. Ausgeblendete oder gelöschte Datenpunkte werden im Diagrammbereich 
nicht dargestellt. Der dargestellte Datentyp hängt vom DataLog-Dateityp und den 
aufgezeichneten Dateien ab. Bohrdatendateien zeigen ein Profildiagramm und, wenn ein 
FPT verwendet wird, ein Druckdiagramm. Druck-Zugkraft-Dateien zeigen ein Druckdiagramm 
und, wenn ein TensiTrak-Sender verwendet wird, ein Zugkraftdiagramm. 
Ansteuerungsdateien (in dieser Anleitung nicht behandelt) enthalten Profilansichts- und 
Draufsichtsdiagramme. 

Die Diagrammbereiche haben folgende gemeinsamen Merkmale: 

Datenpunkte Datenpunkte, die nicht ausgeblendet oder gelöscht wurden 

Werte Wert der im Diagrammbereich enthaltenen Punkte 

Cursorkoordinaten Wenn der Cursor auf eine beliebige Stelle im Diagrammbereich 

gehalten wird, wird der Wert der Koordinaten an dieser Stelle angezeigt. 
Halten Sie den Cursor auf einen Datenpunkt, um die an diesem Punkt 
aufgezeichneten Datenwerte anzuzeigen. 

Zoom Halten Sie die Strg-Taste gedrückt und ziehen Sie den Zeiger durch 

einen Bereich, um ihn zu vergrößern. Halten Sie die Strg-Taste 
gedrückt und klicken Sie auf eine beliebige Stelle im Diagrammbereich, 
um zur normalen Ansicht zurückzukehren. 
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Diagramme bearbeiten und beschriften 

Es gibt mehrere Möglichkeiten zum Bearbeiten und Beschriften von Profil-, Druck und 
Zugkraftdiagrammen. Verwenden Sie zum Beispiel im Menü Edit (Bearbeiten) die Befehle 
unter "Annotations" (Beschriftung), um Formen und Text direkt in Diagramme zu zeichnen 
bzw. schreiben, um Baustellenbedingungen und andere Besonderheiten zu beschreiben, 
oder verwenden Sie die Befehle unter "Properties" (Eigenschaften), um die Grenzen von 
Diagrammen zu ändern.  

Formen zeichnen und Text einfügen 

Halten Sie die Umschalttaste gedrückt und ziehen Sie mit dem Cursor an der gewünschten 
Stelle im Diagramm einen Kasten, um einen Kasten zu zeichnen und Angaben einzugeben, 
die im Diagramm und im gedruckten Bericht enthalten sein sollen. Dadurch wird ein 
Beschriftungs-Dialogfeld geöffnet, das die Koordinaten des Kastens im Diagramm enthält. 

  

Beschriftungs-Dialogfeld 

Alternativ können Sie auf Profil , Druck  oder Kraftdiagrammbeschriftungen  
klicken (alle Befehle sind auch im Menü Edit (Bearbeiten) zu finden) und die Koordinaten von 
Hand eingeben. 

Doppelklicken Sie auf eine vorhandene Beschriftung, um ihre Eigenschaften zu ändern (Text 
kann so nicht geändert werden, nur Objekte). 

Wählen Sie eine einzufügende Form aus dem Drop-Down-Feld Shape (Form) aus. Passen 
Sie die Größen Line weight (Linienbreite) und Font height (Schriftgröße) nach Bedarf an. 
Verwenden Sie die Kontrollkästchen und doppelklicken Sie auf die Ellipsen im Bereich Draw 
Shape (Form zeichnen), um Formeigenschaften und Farben auszuwählen. 
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Aktivieren Sie das Kontrollkästchen Draw Caption (Text zeichnen), um den Bereich 
"Caption" (Text) zu aktivieren. Für einen Text wird keine Form benötigt. Beschriftungen 
werden standardmäßig in der Form zentriert. Um Lage oder Orientierung des Texts zu 
ändern, verwenden Sie die Felder Top - Left (Oben links) und Text Slope (Textorientierung). 

Diagrammeigenschaften bearbeiten 

Um Eigenschaften wie die Diagrammgrenzen und Skalierung zu bearbeiten, klicken Sie auf 

Profil , Druck  oder Kraftdiagrammeigenschaften  (alle Befehle sind auch im 
Menü Edit (Bearbeiten) zu finden). 

 

Dialogfeld "Profildiagrammeigenschaften" 

Um die Koordinaten für die Diagrammgrenzen zu ändern, deaktivieren Sie eines oder beide 
der Kontrollkästchen Auto Scale (Automatisch skalieren) und geben neue Werte ein. 

Datenpunktliste 

Die Datenpunktliste ist eine Tabelle, in der alle Datenpunkte des Jobs der Reihe nach mit 
den zugehörigen Daten aufgelistet sind. Die Einheiten für Tiefe und Neigung werden im Feld 
"Job Information" (Jobangaben) angezeigt. Die Tabelle umfasst folgende Spalten: 

Rod ID (Stangennummer) Stangenummer und Status des Datenpunkts. Es wird 

ein farbiger Flag angezeigt, die den Status der Daten angibt:  

 Roter Flag: Neigung fehlt; geben Sie die Neigung ein, damit der 

Bohrpfad richtig berechnet wird. 

 Violetter Flag: Tiefe fehlt; kennzeichnet für die Bedienperson 

Datenpunkte mit nur Neigung. Öffnen Sie das Dialogfeld "Edit Data 
Point" (Datenpunkt bearbeiten), um je nachdem, welche Daten von 
der Bedienperson für die Tiefe eingegeben wurden, diesen Flag zu 
blau bzw. grün zurückzusetzen. 

 Blauer Flag: Der Datenpunkt wurde bearbeitet 

 Grauer Flag: Daten wurden ausgeblendet oder entfernt 

 Grüner Flag: Überschriebene Daten 

 Schwarzer Flag: Ursprüngliche Daten 

Rod Len. (Stangenlänge) Länge der Stange 

Bore Len. (Bohrungslänge) Länge der Bohrung (Summe der Längen aller 

vorherigen Stangen plus der Länge der aktuellen Stange) 

X Dist. (X-Entfernung) Waagrechte Entfernung vom Eintritt  

Pitch (Neigung) Am jeweiligen Datenpunkt aufgezeichneter Neigungswert 
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Rel. Depth (Relative Tiefe) Die Tiefe des Bohrkopfs unter der Nullhöhenlinie.  

Depth (Tiefe) Senkrechter Abstand des Bohrkopfs von der Geländeoberfläche. 

Dieser Wert kann entweder gemessen, manuell vom Benutzer 
eingegeben oder von der LWD-Software basierend auf eingefügten 
oder fehlenden Daten interpoliert werden. 

Rel. Elev. (Rel. Höhe) Der positive oder negative senkrechte Abstand von der 

Nullhöhenlinie 

Date/Time (Datum/Uhrzeit) Datum und Uhrzeit, zu denen der jeweilige Datenpunkt 

aufgezeichnet wurde. Diese Angaben sind im gedruckten Bericht nicht 
enthalten. 

Type  (Typ) Angaben zum am Datenpunkt aufgezeichneten Datentyp: 

 BL: (Blank) Leer (keine mit dem Datenpunkt aufgezeichneten 

Neigungs- oder Tiefendaten)  

 PO: (Pitch Only) Nur Neigung  

 LL: (Locate Line) Ortungslinie  

 FLP: (Front Locate Point) Vorderer Ortungspunkt  

 IN: (Inserted) Eingefügter Datenpunkt. Neigungs- und 

Tiefenstandardwerte werden von benachbarten Daten interpoliert 
und nicht standardmäßig angezeigt. Diese Daten können bei 
Bedarf durch Überschreiben der aufgeführten Standardwerte 
geändert werden. Der neue Datenpunkt wird alphabetisch 
aufgeführt (z.B. der erste nach Stange Nr. 2 manuell eingefügte 
Punkt wird als 2-A aufgeführt, der zweite als 2-B usw.). 

RawDepth (Rohe Tiefe) Die projizierte Tiefe, die am Ortungsgerät angezeigt wird. 

RawDist (Rohe Entfernung) Horizontale Entfernung an der Stelle, an der ein 

Datenpunkt erfasst wurde (am FLP oder der LL) zum Punkt direkt über 
dem Sender. 

Comment (Anmerkungen) Es können Anmerkungen zu einzelnen Datenpunkte 

eingefügt werden, die in dieser Spalte angezeigt werden (siehe 
Stange/Datenpunkt bearbeiten nachfolgend). 

Verschiedene Datentypen werden in der Datenpunktliste durch Symbole gekennzeichnet: 

Bohr-

gerät 

Eintritt 

Bohrstangen 
Stangenlänge 

Relative Tiefe 
Nullhöhenlinie 

Bohrkopf 

Geländeoberfläche 

(Topographie) 

Tiefe 

Relative Höhe 
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o (Overwritten) Manuell überschriebene Daten  

e (Edited) Stangenlänge wurde bearbeitet  

i (Interpolated) Daten wurden interpoliert  

f (Filled in) Daten wurden eingetragen; Daten fehlten im ursprünglichen 

Upload  

h (Hidden) Daten sind ausgeblendet  

x Neigungsdaten fehlen  

Datenpunkte bearbeiten 

Klicken Sie mit der rechten Maustaste auf einen Datenpunkt in der Tabelle, um ein Pop-up-
Menü mit den Befehlen Befehle "Edit" (Bearbeiten), "Insert" (Einfügen), "Delete" (Löschen), 
"Hide" (Ausblenden) und "Remove" (Entfernen) anzuzeigen. 

 

Datenpunkttabellen-Verknüpfungsmenü 

Stange/Datenpunkt bearbeiten 

Klicken Sie mit der rechten Maustaste auf den Datenpunkt und wählen Sie Edit, oder 
doppelklicken Sie einfach auf einen Datenpunkt in der Liste oder dem Diagramm. Bearbeiten 
Sie die Daten oder fügen Sie ggf. Anmerkungen hinzu. Klicken Sie auf OK, um die 
Änderungen zu speichern oder auf Cancel (Abbrechen). 

  

Dialogfeld "Datenpunkt bearbeiten" 

Kästchen ist automatisch 
aktiviert, wenn Daten für eine 
leere Stange oder mit nur 

Neigung eingefügt werden 

Kästchen wird automatisch 
aktiviert, wenn eine leere 

Stange eingefügt wird 

Stangenlänge in den 
gleichen Einheiten wie die 

Tiefenmessung 
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Wenn ein leerer Datenpunkt vorliegt, wird das Kontrollkästchen Pitch is Missing/Unknown 
(Neigung fehlt/ist unbekannt) standardmäßig aktiviert. Wenn der richtige Neigungswert nicht 
eingegeben wird und das Kästchen deaktiviert wird, hat die Datenlinie im Diagramm eine 
Lücke. Der fehlende Datenpunkt wird im Diagramm hervorgehoben. 

Wenn eine neue Stange eingefügt wird oder ein leerer Datenpunkt oder ein Datenpunkt mit 
nur Neigung aufgezeichnet wird, wird das Kontrollkästchen Depth is Hidden/Unknown 
(Tiefe fehlt/ist unbekannt) standardmäßig aktiviert. Wenn Sie den Tiefenwert nicht eingeben 
und das Kontrollkästchen deaktivieren, hat die Datenlinie im Diagramm eine Lücke und der 
fehlende Punkt wird nicht dargestellt. 

Klicken Sie, um die ursprünglichen aufgezeichneten Daten wiederherzustellen, auf die 
Schaltfläche "Restore Default" (Standardwert wiederherstellen) neben den 
wiederherzustellenden Daten. 

Stange/Datenpunkt einfügen 

Klicken Sie mit der rechten Maustaste auf den Datenpunkt vor der Stelle, an der der neue 
Datenpunkt eingefügt werden soll und wählen Sie Insert. In der Datenliste und im Diagramm 
erscheint ein neuer Datenpunkt. 

Der neue Datenpunkt erhält die selbe Nummer wie der vorherige, mit einem angehängten 
Buchstaben. Zum Beispiel wird der erste manuell nach Stange 2 eingefügte Punkt als 2-A 
aufgeführt, der zweite als 2-B usw.. Die für Neigung und Tiefe aufgeführten Daten werden 
anhand benachbarter Daten interpoliert und die Tiefe wird standardmäßig ausgeblendet. Der 
Stangentyp wird als "IN" für eingefügte Daten aufgeführt. Sie können die Datenwerte nach 
Bedarf ändern.  

Um ursprüngliche interpolierte Werte wiederherzustellen, klicken Sie auf Restore Default 
(Standartwert wiederherstellen) unter dem entsprechenden Datenfeld. 

Eingefügte Stange/Datenpunkt löschen 

Klicken Sie mit der rechten Maustaste auf den zu löschenden Datenpunkt und wählen Sie 
Delete. Der Datenpunkt wird aus der Datenpunktliste und dem Diagramm entfernt.  

Ursprüngliche Daten können nicht gelöscht werden. Falls eine Stange versehentlich zweimal 
aufgezeichnet wurde, wählen Sie Remove, um diesen Datenpunkt zu entfernen. 

Für Eclipse: Daten vom Eclipse-Ortungsgerät werden importiert und als ursprüngliche Daten 
betrachtet. Sie können nicht gelöscht werden. 

Hide (Ausblenden) 

Wenn diese Option ausgewählt ist, erscheint der Datenpunkt zwar noch in der Datenliste, ist 
jedoch im Diagramm ausgeblendet. Die Daten werden in den Berechnungen weiterhin 
berücksichtigt. Im Pop-up-Menü erscheint neben der Option ein Häkchen. 

Remove (Entfernen) 

Wählen Sie diese Option, um den Datenpunkt aus der Liste, dem Diagramm und den 
Berechnungen zu entfernen. Verwenden Sie diese Option bei ursprünglichen Daten, die 
versehentlich zweimal aufgezeichnet wurden. 
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Profildiagramm 

Das Profildiagramm ist eine graphische Darstellung der DataLog-Daten. 

 

Bohrdaten-Profildiagramm 

Datenpunkte 

Datenpunkte werden im Profildiagramm als blaue Punkte dargestellt. Halten Sie den Cursor 
auf einen Datenpunkt, um für diesen Punkt aufgezeichnete Daten anzuzeigen. Klicken Sie 
auf einen Datenpunkt im Profildiagramm, um die entsprechende Zeile in der 
Datenpunkttabelle anzuzeigen. Lücken in den Datenpunkten weisen auf fehlende Daten hin. 

Markierte Datenpunkte (mit grauem Kreis hinterlegte Punkte) weisen darauf hin, dass die 
Stange eingefügt wurde oder die Neigung bearbeitet wurde.  

Für grüne Geländepunkte kann nur die Tiefe bearbeitet werden, danach sind sie auch 
markiert. 

Manchmal ist es nützlich, einen Datenpunkt im Diagramm auszublenden, damit andere 
Elemente angezeigt werden können, zum Beispiel ein Versorgungsleitungs-Flag. Ein im 
Profildiagramm ausgeblendeter Datenpunkt wird in der Datenpunktliste weiter angezeigt. 

Versorgungsleitungs-Flags 

Verwenden Sie Versorgungsleitungs-Flags, um Lage und Typ von Versorgungsleitungen im 
Diagramm und im gedruckten Bericht aufzuzeigen. Um Versorgungsleitungs-Flags 
hinzuzufügen oder zu bearbeiten, klicken Sie auf Versorgungsleitungs-Flags bearbeiten 

 (Menüs Edit > Utility Flags (Bearbeiten > Versorgungsleitungs-Flags)), um das 
Versorgungsleitungs-Flag-Dialogfeld zu öffnen. Oder klicken Sie bei gedrückter 
Umschalttaste auf einen Datenpunkt im Diagramm, um das Dialogfeld zu öffnen, in dem 
bereits ein neuer Flag mit der entsprechenden Lage eingetragen ist. 

 

Versorgungsleitungs-Flag-Dialogfeld 
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Das Versorgungsleitungs-Flag-Dialogfeld enthält folgende Felder: 

Type (Typ) Aus der Drop-Down-Liste auswählen. Der Flag erscheint im 

Diagramm als Kreis mit der von der APWA (American Public Works 
Association) empfohlenen Farbe. 

X Dist (Distance) (X Entf. (Entfernung)) Waagrechte Entfernung auf der 

Geländeoberfläche vom Eintritt zur Versorgungsleitung 

Depth (Tiefe) Vertikale Entfernung von der Oberfläche zur Versorgungsleitung 

Comment (Anmerkung) Der Standardtext ist der Typ der Versorgungsleitung. 

Geben Sie ggf. einen neuen Text ein. 

Text Slope (Textorientierung) Orientierung des Beschriftungstexts im Diagramm 

Versorgungsleitungs-Flags dürfen nicht mit Daten-Flags in Druck-Zugkraft-Dateien 
verwechselt werden, die vom Bediener des Ortungsgeräts während der Datenaufzeichnung 
eingegeben werden. 

Druck-Zugkraft-DataLog-Funktionen 

Zusätzlich zu den am Anfang des vorherigen Abschnitts beschriebenen Funktionen enthalten 
Druck-Zugkraft-Dateien Angaben und Steuerelemente, die spezifisch für die Aufzeichnung 
von Spülungsdruck (von einem Sender mit Drucksensor) und Zugkraft (von einem TensiTrak-
Sender) sind. 

Denken Sie daran: Zeichnen Sie einen Bohrdaten-DataLog zeitgleich mit einem P-T-DataLog 
auf, um die Spülungsdruckdaten mit normalen Senderdaten aufzuwerten und ein typischeres 
Liniendiagramm zu erstellen, wie auf Seite 5 gezeigt. 

Jobangaben 

Um Jobangaben hinzuzufügen und zu bearbeiten, die im gedruckten Bericht enthalten sein 
sollen—wie etwa für den Job zulässige Grenzwerte für Druck oder Zugkraft, den für einen 
TensiTrak-Job installierten Produkttyp und die Richtung aufgezeichneter Daten—klicken Sie 

auf Jobangaben  (Menüs Edit > Job Information (Bearbeiten > Jobangaben)) oder 
doppelklicken Sie auf das Feld "Job Information". 

  

Dialogfeld "Druck-Zugkraft-Jobangaben" 
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Grenzwerte 

Hier können sie Grenzwerte für während der Bohrung und/oder dem Produkteinzug zulässige 
Werte von Druck und/oder Zugkraft eingeben. Die Grenzwerte sind im gedruckten Bericht 
enthalten. 

Use Tension Design Limit (Zugkraft-Grenzwert verwenden) Hier können Sie einen Wert für die für 

das Projekt zulässige maximale Zugkraft eingeben. 

Use Pressure Design Limit (Druckgrenzwert verwenden) Hier können Sie einen Wert für den für 

das Projekt zulässigen maximalen Druck eingeben. 

Wenn ein Grenzwert festgelegt wurde, sind die Datenpunkte in der Liste und im Diagramm 
gelb bzw. rot, um anzuzeigen, dass sie sich dem Grenzwert nähern oder ihn überschreiten. 

Produktangaben 

Material Angaben zum installierten Material für einen TensiTrak-Job 

Length (Länge) Gesamtlänge des während des Einzugs installierten Produkts 

Diam (Durchmesser) Durchmesser des installierten Produkts 

Right to Left  
oder Left to Right (Von rechts nach links oder von links nach rechts) Richtung, in der die 

Daten im Diagramm angezeigt werden. Um einen genauen Vergleich zu 
ermöglichen, sollten die Daten relativ zur Richtung des Pilotbohrungs-
Profildiagramms angezeigt werden. Wählen Sie Right to Left (Von 

rechts nach links), wenn das Produkt vom Austritt der Pilotbohrung aus 
eingezogen wird. Wählen Sie Left to Right (Von links nach rechts), 

wenn die Druck- und/oder Zugkraftdaten ausgehend vom Eintritt einer 
Pilotbohrung aufgezeichnet werden. 

Datenpunktliste 

Die Datenpunktliste ist eine Tabelle, in der alle Datenpunkte des Jobs der Reihe nach mit 
den zugehörigen Daten aufgelistet sind. Die Einheiten für Druck und Kraft werden im Feld 
"Job Information" (Jobangaben) angezeigt. Die Tabelle umfasst folgende Spalten: 

Data Point (Datenpunkt) Nummer und Status des Datenpunkts 

Force (Kraft) Der vom Ortungsgerät am jeweiligen Datenpunkt aufgezeichnete 

Kraftwert. Ein "x" weist darauf hin, dass keine Daten vorliegen. 

Max F. (Maximalkraft) Der vom Ortungsgerät aufgezeichnete maximale 

Kraftwert aller Datenpunkte bis zum angegebenen Datenpunkt. Ein "x" 
weist darauf hin, dass keine Daten vorliegen. 

Pres. (Druck) Der vom Ortungsgerät am jeweiligen Datenpunkt 

aufgezeichnete Druckwert. Ein "x" weist darauf hin, dass keine Daten 
vorliegen. 

Max P. (Maximaldruck) Der während des Jobs erfasste maximale Druckwert bis 

zur Aufzeichnung des Datenpunkts 

Data Flag (Daten-Flag) Markiert, wenn am F5-Ortungsgerät an einem 

angegebenen Datenpunkt ein Flag aufgezeichnet wurde 

Date/Time (Datum/Uhrzeit) Datum und Uhrzeit, zu denen der jeweilige Datenpunkt 

aufgezeichnet wurde. Diese Angaben sind in den Diagrammen und 
gedruckten Berichten nicht enthalten. 
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Datenpunkte entfernen 

Klicken Sie dort auf das Diagramm, wo Sie Datenpunkte entfernen möchten. Die 
Datenpunktliste wird angepasst, um die Gruppe von Datenpunkten in der Nähe dieser Stelle 
anzuzeigen.  

 Um einen Bereich von Datenpunkten in der Liste auszuwählen, klicken Sie auf den 
ersten Datenpunkt und klicken dann bei gedrückter Umschalttaste auf den letzten 
Datenpunkt, um alle Punkte dazwischen auszuwählen.  

 Um mehrere, nicht aufeinanderfolgende Datenpunkte auszuwählen, klicken Sie bei 
gedrückter Strg-Taste auf jeden einzelnen Datenpunkt. 

Klicken Sie mit der rechten Maustaste auf die ausgewählten Datenpunkte und wählen Sie 
Remove (Entfernen). In der Datenpunktliste werden die Punkte gekennzeichnet, die aus dem 
Diagramm entfernt wurden. 

Druckdiagramm  

Das Druckdiagramm zeigt den alle vier Sekunden aufgezeichneten Spülungsdruck im 
Bohrloch, wobei die Daten am Ende jeder Stange als grüner Punkt dargestellt sind. Wenn ein 
Druckgrenzwert eingestellt wurde, werden die Datenpunkte violett oder rot, wenn sich der 
Wert dem Grenzwert nähert bzw. ihn überschreitet. In diesem Fall wurde der Druckgrenzwert 
auf 150 psi eingestellt (siehe Jobangaben auf Seite 40). 

 

Spülungsdruckdiagramm 

Der Spülungsdruck von einem P-T-DataLog erscheint im Diagramm recht gezackt, wie in der 
obenstehenden Abbildung. Zeichnen Sie zeitgleich einen Bohrdaten-DataLog auf, um eine 
glattere Darstellung zu erhalten (siehe P-T-Daten aufzeichnen auf Seite 22). 

Datenpunkte 

Blau Normale Datenpunkte 

Rot Am Punkt wird der Grenzwert für den maximalen Druck bzw. die 

maximale Kraft überschritten. 

Violett Der Druck- oder Kraftwert für diesen Punkt liegt innerhalb von 5 % des 

eingegebenen Grenzwerts. Die Grenzwerte können im Dialogfeld 
"Jobangaben" bearbeitet werden (siehe Seite 40). 

Orange Der maximale Druck (bzw. die maximale Kraft), die bis zu diesem 

Datenpunkt aufgezeichnet wurde 

Datenpunkte, die innerhalb von 15 % des Druckgrenzwerts oder des maximalen Drucks 
liegen werden automatisch zum Drucken ausgewählt. Um diese Auswahl zu ändern, klicken 
Sie mit der rechten Maustaste auf einen Datenpunkt in der Liste und wählen Print (Drucken) 
bzw. Don't Print (Nicht drucken). 
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Gehen Sie zum Auswählen mehrere Datenpunkte wie unter Datenpunkte entfernen auf 
Seite 42 beschrieben vor. 

Sie können Datenpunkte zwar aus den Diagrammen entfernen, in der Datenpunktliste 
werden sie jedoch weiterhin angezeigt (mit "-X" gekennzeichnet). Das kann nützlich sein, 
wenn Daten erfasst wurden, während das Bohrgerät stillstand. Die Daten können jederzeit 
wieder in das Diagramm aufgenommen werden. 

Daten-Flags 

Zu markierten Datenpunkten — Punkte, die mit einem grünen Kreis hinterlegt sind — wurde 
vom Bediener des Ortungsgeräts ein Flag hinzugefügt. Bearbeiten Sie Farbe, Etikett und 
Lage von Daten-Flags im Dialogfeld "Druck-Zugkraft-Daten-Flags", indem Sie auf Data Flags 

 klicken (Menüs Edit > Data Flags (Bearbeiten > Daten-Flags)) oder mit der rechten 
Maustaste auf den Datenpunkt in der Liste klicken und Add Data Flag (Daten-Flag 
hinzufügen) wählen oder auf einen vorhandenen Daten-Flag klicken. 

 

Dialogfeld "Druck-Zugkraft Daten-Flags" 

Wenn während einer Pilotbohrung ein Spülungsdrucksender verwendet wird und die 
Bohrdatendatei, wie oben abgebildet, ebenfalls aufgezeichnet wird, wird mit jeder neuen oder 
gelöschten Stange ein Daten-Flag aufgezeichnet und mit "NewRod" (Neue Stange) bzw. 
"DelRod" (Gelöschte Stange) gekennzeichnet. Die Daten-Flags für neue und gelöschte 
Stangen können im Druckdiagramm ausgeblendet oder angezeigt werden. 

Vom Bediener des Ortungsgeräts während einer Pilotbohrung oder beim Einzug 
Produkteinzug manuell hinzugefügte Daten-Flags werden im Diagramm mit der Flag-
Nummer gekennzeichnet, die angezeigt wurde, als sie aufgezeichnet wurden, wie im 
Zugkraftdiagramm im nächsten Abschnitt gezeigt. 

In LWD hinzugefügte Daten-Flags werden Benutzer-Flags genannt. Sie können 
Anmerkungen zu Benutzer-Flags und zu während der Datenerfassung aufgezeichneten 
Flags hinzufügen. Vom Bediener während der Datenerfassung aufgezeichnete Flags können 
nicht gelöscht werden.  

 

Hinweis Daten-Flags dürfen nicht mit Versorgungsleitungs-Flags verwechselt 
werden. In einer Druck-Zugkraft-Datei kann es keine 
Versorgungsleitungs-Flags geben. 

Das Dialogfeld "Druck-Zugkraft-Daten-Flags" umfasst folgende Felder: 

Stelle, an der der 
Datenpunkt im 

Diagramm erscheint 
Aktivertes Kontrollkästchen 
gibt an, dass der jeweilige 
Daten-Flag im Diagramm 

nicht dargestellt wird 
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Raw DP Index (Verzeichnis der Rohdatenpunkte) Datenpunktnummer in der Liste aller 

Datenpunkte; kann nicht bearbeitet werden 

Show At Pressure (Anzeigen bei Druck) Der Druck, bei dem der Daten-Flag angezeigt 

wird. Wenn das Kontrollkästchen deaktiviert ist, wird der Flag nicht im 
Diagramm angezeigt. 

Show At Force (Anzeigen bei Kraft) Die Kraft, bei der der Daten-Flag angezeigt wird. 

Wenn das Kontrollkästchen deaktiviert ist, wird der Flag nicht im 
Diagramm angezeigt. 

Draw Flag (Flag zeichnen) Verwenden Sie die Kontrollkästchen und doppelklicken 

Sie auf die Ellipsen im Bereich "Draw Flag", um Formeigenschaften und 
Farben auszuwählen. 

Klicken Sie auf Change (Ändern), um Änderungen an der Datei zu speichern und dann auf 
OK zum Beenden. Wenn Sie nur auf OK klicken, wird das Dialogfeld geschlossen, ohne die 
Änderungen zu speichern.  

Der bearbeitete Flag erscheint im Diagramm als Kreis mit der im Bereich "Draw Flag" 
gewählten Farbe. 

Die Standardbeschriftung besteht aus Nummer und Typ des Daten-Flags. Sie können im 
Feld Comment (Anmerkung) eine andere Beschriftung eingeben und im Feld Text Slope 
(Textorientierung) ihre Orientierung ändern. 

Standardmäßig zeigt der Daten-Flag den Druck (die Kraft) an, der gemessen wurde, als der 
Flag aufgezeichnet bzw. hinzugefügt wurde. Verwenden Sie die Kontrollkästchen Show At… 
(Anzeigen bei ...), um ggf. die Markierung von den gemessenen Daten weg zu verschieben. 

Zugkraftdiagramm  

Das Zugkraftdiagramm wird nur für TensiTrak-Jobs angezeigt. Es zeigt die an jedem 
Datenpunkt gemessene Produkteinzugskraft. Datenpunkte sind gelb oder rot, wenn sich ihr 
Wert einem Grenzwert nähert bzw. diesen übersteigt. Im unten abgebildeten Fall wurde der 
Kraftgrenzwert auf 40.000 lbf (1915 kPa) eingestellt. 

 

Zugkraftdiagramm 

Datenpunkte und Daten-Flags im Kraftdiagramm können auf die gleiche Weise manipuliert 
werden, wie im Druck-Zugkraft-Diagramm (siehe vorangehenden Abschnitt). 

Vollständige Anweisungen zur Verwendung der LWD-Software mit dem TensiTrak-System 
finden sie in der DigiTrak F5 TensiTrak-Bedienungsanleitung. 

http://www.digitrak.com/customerservice/downloads.html
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Bohrdaten-DataLog-Datenpunkte 

Halten Sie den Cursor auf einen Datenpunkt, um für diesen Punkt aufgezeichnete Daten 
anzuzeigen. Klicken Sie auf einen Datenpunkt im Profildiagramm, um die entsprechende 
Zeile in der Datenpunkttabelle anzuzeigen. Lücken in den Datenpunkten weisen auf fehlende 
Daten hin. 

Die Datenpunkte haben folgende Farben und Typen:  

Grüne Datenpunkte Der durchschnittliche Druck, der während dieser Stange und allen zuvor 

aufgezeichneten und gelöschten Stangen aufgezeichnet wurde 

Blaue Datenpunkte Der hohe Druck, der während dieser Stange und allen zuvor 

aufgezeichneten und gelöschten Stangen aufgezeichnet wurde. Dies 
entspricht dem Durchschnitt plus 1 Standardabweichung und schließt 
84 % der Druckmesswerte ein (unter Voraussetzung einer 
Normalverteilung). Statistisch sind einige Spitzen über diesem Druck 
aufgetreten. 

Goldfarbene 
Datenpunkte Der maximale Druck, der während dieser Stange und allen zuvor 

aufgezeichneten und gelöschten Stangen aufgezeichnet wurde 

Markierte Datenpunkte Punkte, die mit einem grünen Kreis hinterlegt sind, kennzeichnen 

Stangen, die während des Datenerfassungsprozesses gelöscht wurden. 

Druckdaten können nicht gelöscht werden. Falls während einer anschließend gelöschten 
Stange ein Überdruckereignis aufgezeichnet wurde, wird dies in die Daten der nächsten 
aufgezeichneten Stange übernommen. Um die Lage des Überdruckereignisses zu 
identifizieren, müsste das Druckprotokoll aufgezeichnet und als Druck-Zugkraft-Datei 
hochgeladen worden sein. Diese Datei würde dann Flags enthalten, die alle aufgezeichneten 
und gelöschten Stangen kennzeichnen. 

LWD-Jobs speichern, drucken und verschicken 

Projektdateien speichern 

Klicken Sie zum Speichern eines Projekts auf Speichern (Menüs File > Save (Datei > 
Speichern)). Wenn die Datei bereits gespeichert wurde, wird sie unter dem aktuellen 
Dateinamen und Verzeichnis erneut gespeichert. Wenn die Datei noch nicht gespeichert 
wurde, geben Sie einen Dateinamen ein und wählen Sie das Zielverzeichnis im Dialogfeld 
Save As (Speichern unter) und klicken dann auf Save (Speichern). 

Der Standard-Dateiname lautet DrillData#.dl5 für Bohrdatendateien und Pressure-
Tension#.dl5 für Druck-Zugkraft-Dateien. In beiden Fällen steht "#" für eine Nummer, die mit 
1 beginnt und automatisch hochgezählt wird, wenn mehr Dateien gespeichert werden. 

Um eine offene Datei unter einem anderen Dateinamen oder Verzeichnis zu speichern, 
wählen Sie File > Save As. Ändern Sie Dateinamen und Ablageort nach Wunsch und klicken 
Sie dann auf Save. 

Um eine Unicode-Textdatei mit durch Kommas getrennten Werten (*.csv) zur Verwendung in 
einer Tabellenkalkulation zu exportieren, klicken Sie auf Tabellenkalkulation exportieren  
(Menüs File > Export Spreadsheet (Datei > Tabellenkalkulation exportieren)). 

DCI empfiehlt, eine Kopie jeder endgültigen Jobdatei in einem getrennten Verzeichnis als 
Sicherung zu speichern. 
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Projektdateien drucken und Vorschau anzeigen 

Klicken Sie zum Drucken von Jobdaten auf Drucken  (Menüs File > Print (Datei > 
Drucken)). DCI empfiehlt die Auswahl der Orientierung Landscape (Querformat) über die 
Schaltfläche Properties (Eigenschaften). 

Um vor dem Drucken eine Vorschau anzuzeigen, klicken Sie auf Druckvorschau  (Menüs 
File > Print Preview (Datei > Druckvorschau)). Klicken Sie im Vorschaufenster auf Print, um 
zum Dialogfeld "Drucken" zu gelangen oder auf Close (Schließen), um zur Datei 
zurückzukehren. 

Um Druckeigenschaften zu bearbeiten, wie etwa, Drucker, Papierformat und 

Papierorientierung, klicken Sie auf Drucker einrichten  (Menüs File > Print Setup (Datei 
> Drucker einrichten)). 

Seite eins des Druckjobs enthält Angaben zum Job, wie etwa Baustelle, Kunde und Angaben 
zum Bauunternehmer sowie die Statistikdaten und Anmerkungen zum Job. Seite zwei enthält 
Profilansichts- und Draufsichtsdiagramme. Seite drei und folgende enthalten topographische 
Vermessungsdaten und Bohrdaten. Gelöschte Datenpunkte werden nicht angezeigt. 

Projektdateien verschicken 

Ihre LWD-Projektdateien können von jedem geöffnet werden, der ebenfalls über die DigiTrak 
LWD-Software verfügt. 

Um einen Bericht an einen Kunden zu schicken, bei dem die LWD-Software nicht installiert 
ist, müssen Sie einen PDF-Druckertreiber

2
 installieren und dann auf diesem "Drucker" 

drucken, um eine PDF-Datei des Berichts zu erstellen, die mit jedem PDF-Leser angezeigt 
werden kann. 

Als Alternative zu PDF kann auf Microsoft Windows-Systemen auf dem in der Liste 
verfügbarer Drucker enthaltenen "Microsoft XPS Document Writer" gedruckt werden. Der 
Kunde benötigt Microsoft Internet Explorer, um dieses Encapsulated Postscript (XPS)-Format 
ohne Konvertierungssoftware lesen zu können. Sie finden weitere Angaben zur Verwendung 
dieses Formats unter http://windows.microsoft.com/de-de/windows/print-to-xps-document-
writer. 

                                                      

2
 Beliebt sind zum Beispiel Adobe Acrobat, CutePDF, Bullzip PDF, und FoxIt PDF, von denen teilweise auch 
kostenlose Versionen erhältlich sind. 

http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
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Wenn ein PDF-Schreiber installiert ist (oder Sie XPS-Writer verwenden): 

1. Klicken Sie auf Drucken  (Menüs File > Print (Datei > Drucken)). 

2. Wählen Sie den PDF-Schreiber bzw. Microsoft XPS Document Writer aus der Drop-
Down-Liste Name, um den PDF-Schreiber auszuwählen. 

 

3. Klicken Sie auf Properties (Eigenschaften), wählen Sie "Landscape" (Querformat) 
(empfohlen) und klicken Sie auf OK, um die Orientierung zu speichern und das 
Dialogfeld Properties zu schließen. 

4. Klicken Sie auf OK, um die Datei zu drucken (erstellen). 

5. Wählen Sie das Verzeichnis, in dem Sie die Datei speichern möchten und geben Sie 
einen File Name (Dateinamen) ein. 

6. Klicken Sie auf Save (Speichern). 

Je nach Druckereinstellungen wird die erstellte PDF-Datei automatisch angezeigt oder Sie 
müssen Sie finden und öffnen, um sie zu sehen. Die PDF-Datei lässt sich bequem als 
Anhang an eine E-Mail verschicken. 

Druckertreiber aus 
dieser Drop-Down-

Liste auswählen 
Querformat hier 
auswählen 
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Anhang A - DataLog-Menüsymbole 

Die folgenden Menüoptionen sind für die Funktionen des normalen Bohrdaten-DataLog und 
Druck-Zugkraft (P-T)-DataLog identisch. Die untenstehenden Seitennummern geben die 
Seite an, auf der die Schaltfläche in dieser Anleitung erstmals erwähnt wird. 

Die Schaltflächen sind alphabetisch aufgeführt. 

 

Alle Jobs löschen – Löscht alle im Ortungsgerät gespeicherten Jobs. Seite 28. 

 

Bestehenden Job fortführen – Führt mit den neuen Daten einen bestehenden 

Datalog-Job fort. Wählen Sie die Jobnummer aus der Liste. Seite 17. 

 

DataLog aktivieren/deaktivieren – Wenn die Funktion aktiviert ist, ist das Symbol 
grün und die DataLog-Menüoptionen sind im Ortungsbildschirm verfügbar. Klicken 

Sie auf das Symbol, um DataLog zu deaktivieren. Wenn die Funktion deaktiviert ist, 
ist das Symbol rot und die DataLog-Funktion ist nicht aktiv. d.h. es werden keine 
Daten aufgezeichnet. Klicken Sie auf das Symbol, um DataLog zu aktivieren. 
Seite 4. 

 

Flag setzen – Zeichnet einen Flag auf, während ein P-T-DataLog-Job läuft. Flags 

können in festen Abständen oder an bestimmten Stellen entlang dem Bohrpfad 
aufgezeichnet werden, um die Zuordnung physischer Orte zu aufgezeichneten 
Datenpunkten zu erleichtern. Seite 23. 

 

Job hochladen – Lädt einen Datalog-Job auf einen Computer mit installierter 

DigiTrak LWD-Software hoch. Das Ortungsgerät kann maximal 50 DataLog-Jobs 
pro Dateityp (Bohrdaten oder Druck-Zugkraft) speichern. Seite 26. 

 

Job löschen – Löscht den bzw. die ausgewählte(n) Datalog-Job(s) vom 

Ortungsgerät. Wird auch im Menü "Job löschen" verwendet, um einen zu 
löschenden Job auszuwählen. Seite  

 

Job schließen – Speichert und schließt einen DataLog-Job. Der Job kann 

angezeigt, fortgeführt und hochgeladen werden, bis er aus der Jobliste gelöscht 
wird. Seite 16. 

 

Job unterbrechen – Öffnet das Hauptmenü des Ortungsgeräts, behält jedoch den 

Job ohne Datenaufzeichnung offen. Wenn Sie, ohne das Ortungsgerät 
auszuschalten, zum Ortungsbildschirm zurückwechseln, fährt die 
Datenaufzeichnung unter der aktuellen Jobnummer fort. Seite 16. 

 

Löschen bestätigen – Erscheint nach Eingabe eines Befehls zum Löschen von 

Jobs, um das Löschen zu bestätigen Wählen Sie diese Option, um das Löschen zu 
bestätigen oder wählen Sie Exit (Beenden), um das Löschen abzubrechen. 
Seite 28. 

 

Neuen Job anlegen – Beginnt einen neuen Datalog-Job. Bei der Bohrdaten-

DataLog-Funktion werden Sie aufgefordert, den Job mit Stangenlängen 
einzurichten. Bei der Druck-Zugkraft-DataLog-Funktion erscheint der 
Ortungsbildschirm und die Aufzeichnung beginnt. Seiten 10 (Bohrdaten) und 22 
(P-T). 
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Die folgenden Menüoptionen gelten nur für die Bohrdaten-DataLog-Funktion.  

 

Vermessungspunkt hinzufügen – Zeichnet einen vermessenen Wert für den 

Höhenunterschied (Bezugshöhe) zwischen dem Eintritt und dem Austritt der 
Bohrung auf. Mit diesem Wert kann ein genaueres Profildiagramm in der LWD-
Software erstellt werden. Seite 20. 

 

Leere Stange aufzeichnen – Zeichnet einen Datenpunkt ohne Neigungs- oder 

Tiefenangaben auf. Zur Verwendung, wenn das Ortungsgerät nicht innerhalb des 
Sendebereichs des Senders positioniert werden kann. Seite 14. 

 

Tiefe/Neigung aufzeichnen – Zeichnet Tiefen- und Neigungsangaben an einem 

Datenpunkt am vorderen Ortungspunkt (FLP) oder auf der Ortungslinie (LL) auf. Am 
ersten Stangendatenpunkt und wenn keine Neigungs- oder Tiefenangaben 
verfügbar sind, ist diese Option nicht verfügbar. Seite 14. 

 

Daten einer Teilstange – Zeichnet einen Datenpunkt nach Abschluss einer 

Teilstange auf. Dies wird empfohlen, wenn lange Bohrstangen verwendet werden 
und erhebliche Neigungsänderungen vorliegen oder um kleine 
Topographieänderungen genau graphisch darzustellen. Seite 15. 

 

Nur Neigung aufzeichnen – Zeichnet nur die Neigungangaben an einem 

Datenpunkt auf. Zur Verwendung, wenn das Ortungsgerät nicht über dem FLP oder 
der LL positioniert werden kann. Wenn keine Neigungsangaben verfügbar sind, ist 
diese Option nicht verfügbar. In diesem Fall muss eine leere Stange aufgezeichnet 
werden. Seite 13. 

 

Job einrichten – Richtet eine neuen Job ein oder führt einen bestehenden Job mit 

neuen Daten fort. Nur verfügbar, wenn DataLog aktiviert ist. Wenn kein Bohrdaten-
DataLog-Job gestartet wurde, kann auf diese Option auch vom Ortungsbildschirm 

aus zugegriffen werden, indem Sie den Auslöser halten und den Kippschalter nach 
rechts bewegen.  

 

DataLog anzeigen – Zeigt Daten für einen bestimmten Job an. Seite 8. 

`  

Stangendaten anzeigen/löschen – Zeigt alle aufgezeichneten Datenpunkte. Der 

letzte aufgezeichnete Datenpunkt kann gelöscht werden. Seite 18. 
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Anhang B – Menüs 

Menüleiste und Symbolleisten 

Viele LWD-Menübefehle sind denen in anderen Windows-Programmen ähnlich und einige 
von ihnen haben entsprechende Symbole in der Symbolleiste. Zeigen Sie mit dem Cursor auf 
ein beliebiges Symbol in LWD, um einen seine Funktion beschreibenden Tooltip anzuzeigen. 
Hellgrau angezeigte Symbole oder Menüoptionen sind für den aktuellen DataLog-Dateityp 
nicht verfügbar. Die untenstehenden Seitennummern geben die Seite an, auf der der Befehl 
in dieser Anleitung erstmals erwähnt wird. 

Menü "File" (Datei) 

Befehl Symbol Beschreibung 

New 

 

(Neu) Neuen Job anlegen (Bohrdaten, Druck-Zugkraft, oder 
Ansteuern). Wenn eine Auswahl erfolgt ist, erscheint ein Bildschirm 
mit einem leeren Job. Seite 26. 

Open 
 

(Öffnen) Öffnet einen bestehenden Job. Seite 29. 

Save 

 

(Speichern) Speichert einen offenen Job. Wenn der Job noch nicht 
gespeichert wurde und keinen Namen hat, wird das Dialogfeld Save 
As (Speichern unter) geöffnet. Seite 45. 

Save As 
 

(Speichern unter) Speichert den aktuellen Job unter einem 
anzugebenen Dateinamen und Verzeichnis. Seite 45. 

Print  (Drucken) Druckt den Job. Seite 46. 

Print Preview 
 

(Druckvorschau) Zeigt den Job so auf dem Bildschirm an, wie er auf 
dem Ausdruck erscheint. Seite 46. 

Print Setup 

 

(Drucker einrichten) Zum Auswählen von Optionen wie Drucker, 
Papierformat und Orientierung. Diese Optionen sind normalerweise 
auch in einem Windows Druck-Dialogfeld verfügbar, das über die 
Schaltfläche Properties (Eigenschaften) geöffnet werden kann. 
Seite 46. 

Import Eclipse 
Data  

(Eclipse-Daten importieren) Importiert eine Eclipse DataLog-Datei 
(*.dld) oder Eclipse TensiTrak-Datei (*.ttd). 

Export 
Spreadsheet  

(Tabellenkalkulation exportieren) Exportiert eine Textdatei mit durch 
Kommas getrennten Werten (*.csv) zur Verwendung in einer 
Tabellenkalkulationssoftware. Seite 45. 

Upload Control 
 

(Upload-Steuerung) Verbindung zu einem DigiTrak-Ortungsgerät zum 
Hochladen von Dateien. Seite 26. 

File 1, 2…  (Datei 1, 2…) Öffnet eine vor Kurzem geöffnete Datei. 

Exit  (Beenden) Beendet das DigiTrak LWD-Programm. 

Menü "Edit" (Bearbeiten) 

Befehl Symbol Beschreibung 

Site 
Information 

 

(Baustellenangaben) Eingeben und Bearbeiten von Baustelle, 
Kontaktangaben und Anmerkungen, die im Feld "Site Information" 
oben links im Programmbildschirm angezeigt werden. Verknüpfung: 
Doppelklicken Sie auf das Feld "Site Information". Seite 30. 
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Befehl Symbol Beschreibung 

Display Units 

 

(Anzeigeeinheiten) Wählen Sie die in den LWD-Diagrammen 
verwendeten Einheiten für Tiefe, Neigung, Temperatur und 
Kraft/Druck. Die Einstellung für die Tiefeneinheiten im Ortungsgerät 
bestimmt, welche Einheiten angezeigt werden. Seite 29. 

Job 
Information 

 

(Jobangaben) Anzeigen und Bearbeiten von Angaben zum Job, wie 
Stangenlänge, Vermessungspunktangaben für Bohrdatendateien 
sowie Angaben zum installierten Produkt für Druck-Zugkraft-Dateien. 
Dieses Dialogfeld wird nach dem Hochladen einer DataLog-Datei 
sofort angezeigt. Verknüpfung: Doppelklicken Sie auf das Feld "Job 
Information". Seite 31. 

Profile Chart 
Annotations 

 

(Profildiagrammbeschriftung) Einfügen von Anmerkungen und 
Zeichnungen, die im Profildiagramm angezeigt werden. Verknüpfung: 
Umschalttaste drücken und im Diagramm einen Kasten ziehen. 
Seite 34. 

Pressure Chart 
Annotations 

 

(Druckdiagrammbeschriftung) Einfügen von Anmerkungen und 
Zeichnungen, die im Druckdiagramm angezeigt werden. Verknüpfung: 
Umschalttaste drücken und im Diagramm einen Kasten ziehen. 
Seite 34. 

Force Chart 
Annotations 

 

(Kraftdiagrammbeschriftung) Einfügen von Anmerkungen und 
Zeichnungen, die im Kraftdiagramm angezeigt werden. Verknüpfung: 
Umschalttaste drücken und im Diagramm einen Kasten ziehen. 
Seite 34. 

Profile Chart 
Properties  

(Profildiagrammeigenschaften) Einstellen der Skalierung des 
Profildiagramms. Seite 35. 

Pressure Chart 
Properties  

(Druckdiagrammeigenschaften) Einstellen der Skalierung des 
Druckdiagramms. Seite 35. 

Force Chart 
Properties  

(Kraftdiagrammeigenschaften) Einstellen der Skalierung des 
Kraftdiagramms. Seite 35. 

Utility Flags 
 

(Versorgungsleitungs-Flags) Versorgungsleitungen betreffende Flags 
und Daten hinzufügen, ändern oder löschen. Seite 39. 

Data Flags 
 

(Daten-Flags) P-T-Daten-Flags ändern oder löschen. Seite 43. 

Menü "View" (Anzeigen) 

Befehl Symbol Beschreibung 

Toolbar  (Symbolleiste) Symbolleiste anzeigen oder ausblenden. 

Status Bar  (Statusleiste) Statusleiste anzeigen oder ausblenden. 

Bluetooth 
Device List   

(Bluetooth-Geräteliste) Liste registrierter Bluetooth-Geräte anzeigen. 
Seite 25. 

Menü "Window" (Fenster) 

Befehl Symbol Beschreibung 

New Window  (Neues Fenster) Öffnet die aktuelle Datei in einem neuen Fenster. 

Cascade  (Kaskade) Fenster überlappend anordnen. 

Tile  (Gekachelt) Fenster in nicht überlappenden Kacheln anzeigen. 

Arrange Icons  (Symbole anordnen) Symbole minimierter Fenster anordnen. 

Window 1, 2…  (Fenster 1, 2…) Zum angegebenen Fenster gehen. 
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Menü "Help" (Hilfe) 

Befehl Symbol Beschreibung 

Help Topics 
 

(Hilfethemen) Verzeichnis der Hilfethemen. Seite 29. 

About DigiTrak 
LWD 

 
(Info zu DigiTrak LWD) Versionsnummer der DigiTrak LWD-Software 
anzeigen. 
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DigiTrak DataLog/LWD ™ Bedienungsanleitung - Garantie 1 

BESCHRÄNKTE GARANTIE 

Digital Control Incorporated („DCI“) garantiert, dass jedes DCI-Produkt (ausgenommen Software-Produkte) bei der Versendung ab DCI den zum 
Zeitpunkt der Versendung aktuellen, von DCI veröffentlichten Spezifikationen entspricht und während der unten beschriebenen Gewährleistungsfrist 
(„Gewährleistungsfrist“) frei von Material- und Fertigungsfehlern ist. DCI garantiert darüber hinaus, dass jedes DCI-Softwareprodukt während der 
nachstehend angegebenen Gewährleistungsfrist im Wesentlichen in Übereinstimmung mit den nachstehend in der Dokumentation für derartige 
Software festgelegten Spezifikationen funktioniert. Die hier beschriebene beschränkte Garantie („Beschränkte Garantie“) ist nicht abtretbar oder 
übertragbar und gilt nur für den Erstkäufer („Käufer“), der das DCI-Produkt entweder von DCI oder von einem ausdrücklich von DCI zum Verkauf von 
DCI-Produkten autorisierten Händler („Autorisierter DCI-Händler“) bezieht. 

Die vorstehend genannte beschränkte Garantie unterliegt den folgenden Bestimmungen, Bedingungen und Beschränkungen: 

1. Für die folgenden neuen DCI-Produkte gilt eine Gewährleistungsfrist von zwölf (12) Monaten: Ortungsgeräte, Ferndisplays, Batterieladegeräte 
und wiederaufladbare Batterien sowie Softwareprogramme und Anwendungen. Für alle anderen neuen DCI-Produkte, einschließlich Sender und 
Zubehör, gilt eine Gewährleistungsfrist von neunzig (90) Tagen. Für von DCI angebotene Dienstleistungen, einschließlich Prüfung, Service und 
Reparatur eines DCI-Produkts, dessen Garantie abgelaufen ist, gilt ebenfalls eine Gewährleistungsfrist von neunzig (90) Tagen. Die 
Gewährleistungsfrist beginnt ab dem jeweils späteren der beiden folgenden Zeitpunkte: (i) dem Versanddatum des DCI-Produkts ab DCI, oder (ii) 
dem Datum der Versendung (oder einer anderen Lieferung) des DCI-Produkts von einem autorisierten DCI-Händler an den Käufer. 

2. Sofern ein DCI-Produkt (ausgenommen Software-Produkte) während der Gewährleistungsfrist nicht die garantierten Leistungen erbringt, dann 
wird DCI dieses Produkt inspizieren und, sofern es von DCI als fehlerhaft befunden wurde, nach DCIs ausschließlichem Gutdünken und 
Ermessen entweder reparieren oder ersetzen. Sofern ein Softwareprodukt während der Gewährleistungsfrist nicht die garantierten Leistungen 
erbringt, dann wird DCI nach seinem ausschließlichen Gutdünken und Ermessen dafür sorgen, dass die fehlerhafte Software in einen Zustand 
versetzt wird, in dem sie der Spezifikation für die entsprechende Software entspricht oder den für die fehlerhafte Software bezahlen Kaufpreis 
zurückerstatten. DIE VORSTEHENDEN BESTIMMUNGEN SIND DIE EINZIGEN UND AUSSCHLIESSLICHEN RECHTSMITTEL DES 
KÄUFERS FÜR VERSTÖSSE GEGEN DIESE BESCHRÄNKTE GARANTIE. Sämtliche garantiebezogenen Inspektionen, Reparaturen und 
Anpassungen müssen entweder von DCI oder von einem schriftlich von DCI autorisierten Garantiedienst durchgeführt werden. Alle 
Garantieanträge müssen von einem Kaufbeleg, aus dem das Kaufdatum und die Seriennummer des DCI-Produkts hervorgehen, begleitet sein 
und vor Ablauf der Gewährleistungsfrist eingereicht werden. 

3. Diese beschränkte Garantie gilt nur, wenn: (i) der Käufer das DCI-Produkt innerhalb von vierzehn (14) Tagen nach Erhalt des DCI-Produkts auf 
der Produktregistrierungswebsite access.DigiTrak.com registriert; (ii) der Käufer das DCI-Produkt direkt nach Erhalt in angemessener Weise 
untersucht und im Fall eines erkennbaren Fehlers DCI sofort benachrichtigt; und (iii) der Käufer das unten aufgeführte Verfahren zur 
Geltendmachung von Garantieansprüchen in jeder Hinsicht befolgt. 

Garantieausschlüsse 

Diese beschränkte Garantie gilt nicht für Schäden, einschließlich Schäden an einem DCI-Produkt, aufgrund von: Nichtbefolgung der DCI-
Bedienungsanleitung oder anderer Anweisungen von DCI; Gebrauch eines DCI-Produkts außerhalb der Spezifikationen (u. a. bezüglich der 
Temperatur), für die das DCI-Produkt konzipiert wurde; Fehlgebrauch; Missbrauch; Fahrlässigkeit; Unfall; Feuer; Flut; höherer Gewalt; unsachgemäßer 
Anwendung; Anschluss an falsche Spannung oder Stromquelle; Einsatz falscher Sicherungen; Überhitzung; Kontakt mit Hochspannung oder 
schädlichen Substanzen; Einsatz von Batterien oder anderen, nicht von DCI hergestellten bzw. bereitgestellten Produkten oder Komponenten oder 
anderer außerhalb der Kontrolle von DCI liegender Vorkommnisse. Diese beschränkte Garantie gilt weder für Geräte, die nicht von DCI hergestellt 
oder geliefert wurden, noch ggf. für Schäden oder Verluste, die durch den Einsatz eines DCI-Produkts in einem anderen als dem angegebenen Land 
verursacht werden. Der Käufer verpflichtet sich, die Eignung des DCI-Produkts für den beabsichtigten Einsatzzweck sorgfältig zu prüfen und alle von 
DCI gelieferten Anleitungen (einschließlich allfälliger aktualisierter DCI-Produktinformationen, die auf der vorangehend angegebenen DCI-Website zu 
finden sind), sorgfältig zu lesen und genau zu befolgen. Diese beschränkte Garantie erfasst auf keinen Fall Schäden, die während des Versands des 
DCI-Produkts an oder von DCI entstehen. 

Der Käufer erklärt sich damit einverstanden, dass die vorstehende beschränkte Garantie durch folgende Umstände ungültig wird:(i) Änderung, 
Entfernung oder Verfälschung der Seriennummer oder am DCI-Produkt angebrachter Etiketten mit Identifizierungsinformationen, Anweisungen oder 
Siegeln; oder (ii) nicht autorisierte Demontage, Reparatur oder Modifikation des DCI-Produkts. In keinem Fall haftet DCI für Kosten oder Schäden, die 
auf ohne ausdrückliche schriftliche Genehmigung von DCI vorgenommene Änderungen, Modifikationen oder Reparaturen des DCI-Produkts 
zurückzuführen sind. Ferner ist DCI nicht für Verluste oder Schäden an dem DCI-Produkt oder anderen Geräten verantwortlich, die entstehen, 
während diese sich in der Obhut einer nicht von DCI autorisierten Serviceagentur befinden. 

DCI übernimmt keinerlei Garantie oder Gewährleistung für die Genauigkeit von Daten oder Informationen, die von Horizontal-Richtbohr(HDD)-
Ortungssystemen angezeigt oder erzeugt werden. Die Richtigkeit oder Vollständigkeit solcher Daten kann durch eine Vielzahl von Faktoren 
beeinträchtigt werden, einschließlich u. a. durch aktive oder passive Signalstörungen (einschließlich Salzwasser) und andere Umweltbedingungen, 
unterlassene Kalibrierung oder unsachgemäßen Gebrauch des Geräts sowie weitere Faktoren. Zudem übernimmt DCI keinerlei Garantie oder 
Gewährleistung und lehnt jegliche Haftung ab für die Richtigkeit und Vollständigkeit von Daten, die von einer externen Quelle erzeugt werden, oder die 
von aus einer externen Quelle erzeugten und gegebenenfalls auf einem DCI-Gerät angezeigten Daten gewonnen werden, einschließlich u. a. von 
Daten, die von einem HDD-Bohrgestell eingehen. 

DCI behält sich das Recht vor, DCI-Produkte von Zeit zu Zeit abzuändern und zu verbessern. Der Käufer ist sich dessen bewusst, dass DCI nicht 
verpflichtet ist, früher hergestellte DCI-Produkte so nachzurüsten, dass sie derartige Änderungen enthalten. 

mailto:dci@digital-control.com
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DIE OBEN BESCHRIEBENE BESCHRÄNKTE GARANTIE IST DCIS EINZIGE GARANTIE UND ERSETZT ALLE ANDEREN AUSDRÜCKLICHEN 
ODER STILLSCHWEIGENDEN GARANTIEN, EINSCHLIESSLICH U. A. DER STILLSCHWEIGENDEN GARANTIE VON HANDELSÜBLICHKEIT 
UND EIGNUNG FÜR EINEN BESTIMMTEN ZWECK, NICHTVERLETZUNG VON RECHTEN SOWIE SICH EVENTUELL IM RAHMEN DER 
VERPFLICHTUNGSERFÜLLUNG, IM ZUGE DER GESCHÄFTSBEZIEHUNGEN ODER AUS HANDELSBRAUCH ERGEBENDER 
STILLSCHWEIGENDER GARANTIEN, DIE HIERMIT ALLE AUSGESCHLOSSEN WERDEN. Sofern das unten beschriebene Verfahren zur 
Geltendmachung von Garantieansprüchen von DCI im Wesentlichen eingehalten wurde, stellt dieses Verfahren die einzige und ausschließliche Abhilfe 
dar, die dem Käufer bei Verstoß gegen die beschränkte Garantie zusteht. 

Rechtsbehelfs- und Haftungsbeschränkung 

Weder DCI noch sonst irgendjemand, der an der Schaffung, Herstellung oder Lieferung des DCI-Produkts beteiligt ist, haftet für jegliche 
Schäden, die durch die Verwendung des DCI-Produkts oder die nicht mögliche Nutzung des DCI-Produkts entstehen, einschließlich u. a. 
mittelbare, konkrete, beiläufig entstandene Schäden oder Folgeschäden bzw. Schadensersatz für Absicherung, Verlust von Informationen, 
entgangenen Gewinn, entgangene Einkünfte oder Nutzung, welche der Käufer aufgrund von Garantieverstößen, Vertragsbruch, 
Fahrlässigkeit, verschuldensunabhängiger Haftung oder sonstiger Rechtstheorien geltend macht, selbst wenn DCI die Möglichkeit solcher 
Schäden mitgeteilt wurde. Der Umfang der Haftung von DCI übersteigt keinesfalls den Kaufpreis, den der Käufer für das DCI-Produkt gezahlt 
hat. Soweit das einschlägige Recht den Ausschluss oder die Beschränkung der Haftung für beiläufig entstandene Schäden, Folgeschäden 
oder ähnliche Schäden nicht zulässt, findet der vorstehend bezüglich derartiger Schäden geregelte Haftungsausschluss keine Anwendung. 

Diese beschränkte Garantie verleiht Ihnen bestimmte Rechte. Darüber hinaus stehen Ihnen möglicherweise weitere Rechte zu, die von Land zu Land 
verschieden sind. Diese beschränkte Garantie unterliegt dem Recht des Bundesstaates Washington. 

Verfahren zur Geltendmachung von Garantieansprüchen 

1. Bei Problemen mit Ihrem DCI-Produkt müssen Sie sich zunächst mit Ihrem autorisierten DCI-Händler in Verbindung setzen, von dem Sie das 
Produkt erworben haben. Sollte das Problem über Ihren autorisierten DCI-Händler nicht gelöst werden können, so setzen Sie sich bitte zwischen 
6.00 Uhr und 18.00 Uhr PST (pazifische Zeitzone) unter Telefonnummer 1.800.288.3610 (bzw., außerhalb den USA, unter der für dieses Land 
angegebenen Telefonnummer) mit der Kundendienstabteilung von DCI in Kent, Washington, USA in Verbindung, und lassen Sie sich mit einem 
Kundendienstvertreter verbinden. Bevor Sie ein DCI-Produkt zwecks Kundendienst an DCI zurücksenden, müssen Sie eine „Return Merchandise 
Authorization“-Nummer (RMA) anfordern. Sollten Sie dies nicht tun, kann dies zu Verzögerungen führen oder sogar dazu, dass Sie das DCI-
Produkt unrepariert zurückerhalten. 

2. Bei der telefonischen Kontaktaufnahme mit einem Kundendienstvertreter von DCI wird dieser versuchen, Ihnen bei der Fehlersuche während der 
tatsächlichen Benutzung des DCI-Produkts vor Ort behilflich zu sein. Bitte sorgen Sie dafür, dass hierfür alle relevanten Geräte und eine Liste 
der Seriennummern aller DCI-Produkte zur Verfügung stehen. Die Fehlersuche vor Ort ist wichtig, da viele Probleme nicht auf defekte DCI-
Produkte, sondern auf Bedienungsfehler oder ungünstige Umgebungsbedingungen des Käufers bei der Bohrung zurückzuführen sind. 

3. Wenn im Rahmen der Fehlersuche vor Ort und des Gesprächs mit einem DCI-Kundendienstvertreter ein Fehler an einem DCI-Produkt bestätigt 
wird, wird der Vertreter eine RMA-Nummer zur Autorisierung der Rücksendung des DCI-Produkts mitteilen und Ihnen entsprechende 
Versandanweisungen geben. Sie sind für alle Transportkosten einschließlich Versicherung verantwortlich. Wenn DCI nach Erhalt des DCI-
Produkts und nach der Durchführung diagnostischer Tests feststellt, dass das Problem durch die beschränkte Garantie abgedeckt ist, werden die 
erforderlichen Reparaturen und/oder Anpassungen vorgenommen und es wird ein voll funktionsfähiges DCI-Produkt umgehend an Sie 
zurückgesandt. Sollte das Problem nicht durch die beschränkte Garantie abgedeckt sein, so werden Sie über den Grund hierfür informiert und 
erhalten einen Kostenvoranschlag für die Reparaturkosten. Wenn Sie DCI mit der Wartung oder der Reparatur des DCI-Produkts beauftragen, so 
wird die Arbeit umgehend durchgeführt und das DCI-Produkt danach an Sie zurückgesandt. Die Kosten für Tests, Reparaturen und 
Anpassungen, die nicht unter die beschränkte Garantie fallen, sowie die Transportkosten werden Ihnen in Rechnung gestellt. In den meisten 
Fällen können Reparaturen innerhalb von 1 bis 2 Wochen durchgeführt werden. 

4. DCI hält eine beschränkte Anzahl von Leihgeräten bereit. Bei Bedarf und Verfügbarkeit wird sich DCI bemühen, Ihnen ein solches Leihgerät per 
Übernacht-Zustellung zur Benutzung zuzusenden, während sich Ihr Gerät bei DCI in Reparatur befindet. Abgesehen von außerhalb der Kontrolle 
von DCI liegenden Umständen wird DCI sich in angemessener Weise bemühen, Ihre durch Garantiefälle verursachte Ausfallzeit so gering wie 
möglich zu halten. Wenn Ihnen DCI ein Leihgerät zur Verfügung stellt, muss Ihr eigenes Gerät spätestens am zweiten Arbeitstag nach Erhalt des 
Leihgeräts bei DCI eintreffen. Nach Erhalt Ihres reparierten DCI-Produkts müssen Sie das Leihgerät per Übernacht-Zustellung an DCI 
zurücksenden, so dass es dort spätestens am zweiten Arbeitstag, nachdem Sie das reparierte Gerät erhalten haben, eintrifft. Sollten diese 
Fristen nicht gewahrt werden, werden für jeden zusätzlichen Tag, um den die Rückführung des Leihgeräts an DCI verzögert wird, Mietgebühren 
fällig. 

Produktvorführungen 

DCI-Mitarbeiter halten sich gegebenenfalls vor Ort auf, um die grundlegende Handhabung, Eigenschaften und den Nutzen von DCI-Produkten 
vorzuführen. Der Käufer bestätigt, dass DCI-Mitarbeiter lediglich für Vorführungen von DCI-Produkten anwesend sind. DCI erbringt KEINE Ortungs- 
oder anderen Beratungs- bzw. vertraglich vereinbarten Dienste. DCI übernimmt keinerlei Schulungsverpflichtungen für den Käufer oder andere 
Personen, und DCI übernimmt keine Verantwortung oder Haftung für Ortungs- oder andere an dem Standort ausgeführten Arbeiten, an dem DCI-
Mitarbeiter anwesend sind oder waren bzw. an dem sich DCI-Geräte befinden oder befanden. 

Der vorliegende Text ist eine Übersetzung des englischsprachigen Originaldokuments, die lediglich als 
Arbeitserleichterung für den Käufer des Produkts dient. Bei Unterschieden in der Bedeutung sowie bei 
unterschiedlichen Auslegungen zwischen der Übersetzung und der englischsprachigen Originalfassung ist daher das 
Original maßgebend. Eine Kopie des englischsprachigen Originals finden Sie auf der Website www.DigiTrak.com 
Klicken Sie unter Service & Support (Kundendienst), auf Documentation (Dokumentation) und wählen Sie die 
gewünschte Anleitung aus dem Drop-Down-Menü Manuals (Bedienungsanleitungen). 
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